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Notice 

 
Information in this document is subject to change without notice. Till Photonics GmbH is not liable for 

error contained in this document or for incidental or consequential damages in connection with the use of 

this software. 
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Before you start 
Thank you for purchasing the Till Photonics Live Acquisition software. This manual provides 

information about the operation of the software and how it is configured to work with the 

hardware. Please familiarize with your hardware setup and manuals where appropriate. 

 

 

Software protection: 
The Live Acquisition software is protected by a USB dongle, which has to be plugged into the 

computer on which the software is run. 

 

 

 
Figure 1: USB Key required for using the Live Acquisition Software 

 

The Live Acquisition Software can be installed without the dongle but cannot be started without 

it. 

If a USB dongle of TILLvisION was installed/used on the computer prior to the Live Acquisition 

software it might be necessary to reinstall the Dongle driver. (see Trouble shooting: Chapter 14) 

 

Info: The Live Acquisition software is available in many configurations. It might be 

possible that this manual describes functions that are not available in your purchased 

version of Live Acquisition. 
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1 Introduction 

 
 

Live Acquisition (LA) is more than a software program. It is a part of the LA complete 

microscopy analysis system. Combined with the robust Offline Analysis application and various 

software plug-ins and modules for hardware expansions, it is in fact, the only real real-time 

system you will ever need. As it is both tightly bundled with its ecosystem of hardware (cameras, 

microscopes, light sources, etc) and it is flexible enough to have software modules added or 

changed.  It is capable of such control and data collection operations as: 

 

 Pre/Post analysis of conducted experiments for Kinetics, RATIO, FRET and FRAP 

 Out of the box default experiments such as multi-wavelength experiments, Z Stack, Time 

Lapse, Tile and Stitch, FRAP and more to facilitate rapid learning curves when first using 

the software 

 Sets a precise, operating system independent timing for very complex measuring 

protocols due to its built-in intelligent microcontroller 

 Commands and responses to external electro-optical devices like cameras, microscopes, 

mechanical sliders, mechanical stages, galvos, mirrors, and all the other devices that are 

needed to take and analyze pictures in the visual spectrum 

 Fixed and programmable external hardware trigger events (IN/OUT) which allow 

integration with existing hardware as well as updates as new hardware and hardware 

features become available 

 Intrinsic control of complex screening with Petri dishes, slides, and well plates via easy-

to-use navigation controls 

 

For what counts at the end of the day is that you have your experiment completed.  The Live 

Acquisition solution is an invaluable tool to assist you in getting there.  And then it allows you to 

analyze your data in great length both online while collecting more data and offline when you are 

processing the data. 
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The out of the box nature with pre-built sample experiments and analytic routines will allow even 

a novice user to work with a very powerful set of tools that can create and crunch data. Chances 

are that you will not be aware of many of its features unless you have read the manual carefully 

as you begin exploring the advanced configuration options. You will be surprised, how many 

complex experiments you can actually do if you are using the correct approach and using the 

flexibility in the system to custom tailor your experiment to your needs.   

 

 
 

Figure 2: Live Acquisition and the Offline Analysis application 

 

Live Acquisition solution works hard to make the user interface more intuitive so that you don’t 

have to work hard. Getting the experiment running with a minimal investment of time is a reality 

with Live Acquisition and not just a nice to have.  But in those instances where the complexity of 

the experiment reflects to a complexity in setting up the procedure to execute it, the Live 

Acquisition solution provides a framework of ready to plug in tools to assist you as well as the 

ability to craft custom tools to make your work easier. And not to be forgotten is the philosophy 

behind the company that delivers this solution to you. The philosophy has been to value the 

flexibility of an experiment as well as the ability to set it up in a quick and intuitive manner. 

1.1 Where to Find What - Order of Reading 

The documentation found in this manual is divided into the following parts: 

 Introduction 

 GUI Overview 

 

Also on the installation CD is the complete documentation in electronic form. The following 

documents are included: 

 Live Acquisition Installation and Configuration Guide (pdf) 

 Live Acquisition Users Manual (pdf) 

  (Optional) LA Browser Help Tool (Windows Help files) 

 

In the ‘Installation and Setup’, you can find instructions for a complete installation of the Live 

Acquisition software package. The following add on packages are detailed further in their 

respective users guides but are installed with the same installation and setup procedure found in 

the LA package(s) and Bundles. 
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Tabel 1: Feature list of LA Bundels 

 
LA Imaging LA Advanced LA Premium Offline Analysis 

Main modules  Live Acquisition  Live Acquisition  Live Acquisition   

 Protocol Editor  Protocol Editor  Protocol Editor   

 Offline Analysis  Offline Analysis  Offline Analysis  Offline Analysis  

Analysis modules  Kinetics  Kinetics  Kinetics  Kinetics  

 RATIO  RATIO  RATIO  RATIO  

Additional    

Analyses/Modules  

  FRET   

  FRAP   

   Deblur   

Additional 

Experiments  

  DynamicFRAP   

Optional Modules  FRET,  

Deblur  

FRET,  

FRAP,  

Deblur  

DynamicFRAP,  

DualCamera  

Dual Camera  FRET,  

FRAP,  

Deblur  

LA Software Package Optional Components 

 Offline Analysis 

 Protocol Editor 

 Live Analysis FRET (for on- and offline FRET analysis) 

 Live Analysis FRAP (offline FRAP analysis with fitting functions) 

 Dynamic FRAP three extra FRAP experiments 

 Deblur (No-neighbor, nearest neighbor and inverse filter for debluring z-stacks) 

 DualCamera (Simultaneous acquisition with two cameras) 
 

 

Tabel 2: Supported devices in the LA Software Bundles 

 LA Basic LA Imaging LA Advanced LA Premium 
Cameras All Cameras All Cameras All Cameras All Cameras 

ICU     

Polychrome V      

Oligochrome     

Oligochrome µICU     

Lasers (LLC)     

TILL Stage     

Pifoc     

iMIC &  uiMIC     

Polytrope I&II     

Yanus     

LLC Fiber switch     

Andromeda     
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Once the installation and configuration manual has been perused and the software loaded and 

configured, then it is time to become familiar with the acquisition framework. 

 

Once a basic familiarity with the GUI is achieved, the next step of reading and investigation is in 

the ‘Experiment How To Manual.’ This is a description from a more practical point of view for 

the various out of the box experiment setups that can be found in the Live Acquisition software 

package. Here can be found some more detailed configuration information on how user definable 

experiments can be created.   
 

1.1.1 Where to find Help 

You can get help from the following locations: 

 

 Electronic Manuals 

 Online Support 

 

To make it easy to use most parts of the Live Acquisition software package they have online help.  

Passive popup boxes are prevalent in the software package describing what an individual control 

does and what an individual result field shows. Simply move the cursor over the item in question 

to get a tool tip for help. You can also view the online help in a searchable format via the main 

menu. And when this does not provide a sufficient level of information, you can find pdf files of 

the complete documentation on the delivery CD. As updates become available and as new sample 

macros, plug-in, and scripts become available they can be found on our webpage.  

(http://www.till-photonics.com/Support/ ) For answers to specific questions, send an e-mail to: 

service@till-photonics.com. 

http://www.till-photonics.com/Support/support.php
mailto:service@till-photonics.com
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1.1.2 Key Features of Live Acquisition 

The Live Acquisition software package provides advanced image acquisition with full control of 

the acquisition parameters.  It allows planning, management and execution of complex 

experiments that go beyond mere image acquisition. The Live Acquisition solution also includes 

online and offline data analysis and image processing functionality with the LA Offline Analysis 

Application and 3rd party software vendors like Fiji (an ImageJ distribution). 

1.1.3 Graphical User Interface 

The concept behind the Live Acquisition GUI is one of a merger between hardware and standard 

software interfaces. All the controls that you use on a regular basis are in the same location on the 

screen and are within easy grouping distance of controls that are used together. 

 

When a second monitor is available it can be used for the Offline Analysis Application (when 

only one monitor is attached both programs can still run but must be windowed or exchanged). 

This allows one to see the results of the experiment in a full window directly beside the window 

controlling the hardware operations.  This means fewer keystrokes and changing of focus and 

minimizing and maximizing of windows. Full control and full overview of the acquired data can 

be had in a single glance. 

 

 

 
Figure 3: 2 Screen layout of Live Acquisition Software with LA on the left side and Offline 

Analysis on the right. 

 

Especially when one realizes that to control a microscope without eyepieces and without any 

direct manual control knobs is a considerable challenge and requires novel concepts, not just a 

mere projection of manual knobs onto the screen. In the case of the Live Acquisition solution, the 

user can concentrate exclusively onto the image or onto one or more analysis window(s) and not 

have to worry about manipulating the buttons, menus, icons, and scroll bars when collecting that 

all important data. 
 



                         Live Acquisition Software Documentation v2.2.0 

16 

 

2 LA GUI Overview  

2.1 Starting up: The Welcome Dialog 

This chapter assumes that your TILL Photonics system has been pre-configure by the factory or 

by the technician that installed the system. If a System has to set-up from scratch, maybe because 

of a computer crash, please read chapter 14. 

 

When Live Acquisition starts-up it shows the “Welcome Dialog”, where the user can select his 

account and then his hardware configurations. In labs with more than one user the settings of each 

user are preserved by this way. 

Going from the top to the bottom of the dialog, there are three main sections: 

1. The user and configuration selectors with the “edit/configure” button to the right. 

Pressing the edit button will take the user to a configuration dialog. In these cases the 

User management or the Device Configuration dialog for connecting the imaging system 

devices. 

2. The Task chooser section where the user can go directly to LA or open the Protocol 

editor window directly to load the last used protocol or to restore the last settings and 

resume where he/she left off the last time. If LA is started for the first time the option  

“Restore Last Workspace” will not be available. 

3. The bottom section has the option to hide this dialog on start-up completely, in case of 

basic imaging systems, where only one hardware configuration is needed. And the 

“continue” button is located here where the LA can be started. 

 

 
Figure 4: Welcome dialog when LA starts up 
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2.2 Familiarization with the LA GUI Controls  

The Graphical User Interface (GUI) is designed to be easy to use so that you can get the 

experiment running with a minimal investment of time.  

The tools for the inevitable hand grips to maneuver the microscope are placed, clearly arranged, 

on a panel on the left side of the screen. Additional controls dealing with the actual image under 

the objective are in a smaller control panel on the right hand side of the main viewing screen. The 

center area is referred to as the viewing panel.  

 
 

 

Figure 5 : LA screen after start up on an iMIC system 

  

The GUI is adapted to closely resemble generic hardware interfaces whenever possible. Mostly 

from the perspective that even when you are changing between various displays and experiments. 

The critical controls always are in the same location so that you do not have to go hunting for 

them and can remain focused on what matters most, the Experiment. It is also kept as simple as 

possible with the controls needed for the experiment being dynamically loaded as you select the 

experiment.   

 

What you can see from the dashboard concept is that the controls for the stage (x, y, and z axis) as 

well as the objective are always easily accessible and in the same location. The controls to take a 

picture in either live or still mode, to launch an experiment, or to save or delete default 

experiment configurations is also always in the same place and easy to access. This design 

concept leaves the maximum area available for observation of the experiment. As well as leaving 

the ‘dashboard’ uncluttered without unnecessary control, menus, and dialogues. 

 

Various experiments require different configurations and settings which is why there is a section 

left available on the dashboard control for new control windows to be dynamically inserted 

depending on the experiment currently active. A large number of controls can be accessed with a 

slide bar on the right hand side of this main hardware control window while leaving the primary 
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controls always within easy reach and without cluttering the viewing area. Many of the controls 

are able to be minimized thereby freeing up more of the control window. 

 

 
 

 
Figure 6: Screen Layout 
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The LA is designed with ergonometric and ease of utilization in mind. Data visualization in the 

largest format possible as well as ease of finding the controls without losing concentration on 

what is most important…the research and investigation of the samples. 

 

All controls are so constructed that various input devices can be used and you are not tied to a 

keyboard on your lab desk.  In its default configuration, the GUI supports keyboard, mouse, USB 

HID as well as3D Connexion Joysticks. When heavy data entry tasks are required the keyboard 

can be the most efficient input device. But in a darkened laboratory and by using the intuitive and 

programmable interface of the mini keyboard, joystick and a standard mouse, the keyboard can be 

put away and the full functionality of the Live Acquisition solution is still at a finger click away 

and your focus can always remain on the experiment window without having to hunt down keys 

on the keyboard. 

 

In keeping with this concept the control windows are hidden when they are not needed thereby 

keeping the viewing panel large and robust. The above figure shows two examples of this in that 

the grayed out panels can be hidden thereby increasing the size of the viewing panel but at the 

same time allowing the most important controls to always be visible and at your fingertips. 
 

2.2.1 Description of the Hardware Interfaces for the LA GUI Controls  

In keeping with the ergonometric approach and the design methodology that the most important 

activity is watching what is going on with the sample, various hardware input techniques have 

been developed to keep the focus on the sample. 

 

In this regards the various keyboard keys, mouse buttons, and 3D Connexion Space Navigator 

controls have been worked into a unified whole to ease the navigation of the software without 

having to move the mouse, keystrokes or eyes repeatedly to hunt for and find buttons, controls, 

menus, or pull downs. 
 

2.2.1.1 Mouse Controls 

The mouse is the main control for manipulating the LA GUI. 

 
Tabel 3: Mouse functions in LA 

Motion / Button Action (Needed in Combination) 

Move the mouse Moves the cursor None 

Press left button of the mouse When in a text control sets the 

modal focus allowing the text 

to be changed. 

 

When on a button activates the 

button. 

 

When on a slider control 

allows the slider to be 

manipulated. 

None 

Right click of the mouse Opens the context menu of a 

control if available. 

None 
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Mouse Scroll Wheel Changes the focus when the 

mouse is over the viewing 

panel.  When rolling up 

increases the focus height and 

when rolling down decreases 

the focus height. 

None 

Press Mouse Wheel Allows changing the rotation 

of ROIs by moving the mouse 

up and down 

 

Table 1: Mouse Controls 
 

2.2.1.2 Keyboard Controls – Short cuts 

Various keyboard shortcuts have been set aside to control various features of the software.  The 

goal of these shortcuts are to keep the eyes focused on the viewing panel and the mouse over the 

image without having to refer back to any other controls thereby breaking eye contact with what 

the specimen is doing. 

 
Tabel 4: Keyboard short cuts for accessing LA functions 

Key Stroke Action (Needed in Combination) 

SPACEBAR Will set a time marker in an 

active experiment.  The 

imaging database can then be 

referenced to see what the user 

found at an interesting point in 

time without the need to 

interfere with the experiment 

execution. 

None 

+  Will set an image marker in 

both SNAP, LIVE, and 

EXPERIMENT.  Both the 

imaging database and the LA 

Acquisition primary controls 

will be updated.  The imaging 

database and/or the acquisition 

controls can then be 

referenced to see what the user 

found at an interesting point in 

space without the need to 

interfere with the experiment 

execution.  This allows rapid 

return to an Area of Interest 

(AOI). 

None 

 

NOTE: Works with both the 

larger numpad button as well 

as the smaller standard key 

SHIFT Will change the Viewing 

Panel so that an overlaid 

secondary viewing pane is 

created.  This allows re-

centering the viewing panel by 

placing the mouse and making 

a left click. 

The mouse movement &  the 

mouse left button 
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CTRL Will open an overlaid step 

control for focusing in the 

view panel.  Use of the mouse 

to select and left click a new 

step control changes the 

default focus steps. 

The mouse movement &  the 

mouse left button 

ALT Temporarily disable the image 

acquisition if the z position is 

changed or the light source 

settings like the wavelength is 

changed. 

None 

X Will open an overlaid virtual 

joystick control in the viewing 

panel.  This allows fine 

movement joystick control by 

using the mouse as a joystick. 

The mouse movement 

ALT-Enter Switching to full screen image 

view or back to windowed 

mode 

 

Ctrl + cursor left Got to the previous xyz 

position marker in the position 

marker list 

 

Ctrl + cursor left Got to the next xyz position 

marker in the position marker 

list 

 

Cursor keys Moves the stage on frame into 

the given direction 

 

Page up and page down Changes the focus with the 

last set step size 

 

Ctrl-T Initiates a test run of the 

currently open/edited protocol 

(this does not save the images) 

 

Ctrl-R Runs the currently selected 

protocol and saves the 

acquired images 

 

Ctrl-S Save the currently displayed 

image to the disk 

 

Ctrl-Shift-S “Save as…” short cut. Saves 

the currently displayed image 

to the disk and will prompt for 

a filename and directory.  

 

Crtl-1 Show/Hide the protocol 

parameter panel 

 

Ctrl-2 Show/Hide the light source 

control panel 

 

Ctrl-3 Minimize/maximize the 

Protocol Editor 

Protocol Editor needs to be 

open/active 

ALT-F4 Quits the LA Software  

Del Deletes a ROI if it is selected 

in the image display. 
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Table 2 : Keyboard Controls 

2.2.1.3 3D Connexion Space Navigator Controls (in LA) 

The secondary mouse/joystick has been set aside to control various features of the software.  The 

goal of these shortcuts is to speed navigation and the saving of data. 

 

Motion / Button Action (Needed in Combination) 

Joystick Move (left, right, up, 

down) 

Rapid screening of a sample.  

Allows panoramic movement 

or joystick movement 

depending on preferences 

settings so that the viewing 

panel shows neighboring CCD 

images from the camera. 

None 

Push joystick down Saves the current image None 

Left joystick button Will set an image marker in 

both SNAP, LIVE, and 

EXPERIMENT.  Both the 

imaging database and the LA 

Acquisition primary controls 

will be updated.  The imaging 

database and/or the acquisition 

controls can then be 

referenced to see what the user 

found at an interesting point in 

space without the need to 

interfere with the experiment 

execution.  This allows rapid 

return to an Area of Interest 

(AOI). 

None 

Right joystick button Allows the configuration of 

the sensitivity of the controls. 

None 

Table 3: Space Navigator Controls 
 

2.2.1.4 USB Joystick (HID compatible) 

Connecting as USB Joystick, digital or analog, will allow controlling the xy-movement of a 

motorized stage. 

Switching between a (camera) frame wise and continuous xy-movement is done by deselecting or 

selecting the Joystick move. 

Activating the joystick in LA is done with the menu item Config > Start HID joystick. LA does 

not need to be restarted. 
 
 

3 Acquiring images 
 

The Live Acquisition software offers many possibilities to acquire images and also complex 

experiments in multiple dimensions, time, multiple channels, xy and z. Some functions described 



                         Live Acquisition Software Documentation v2.2.0 

23 

 

in this chapter may need optional available modules of the LA Software, like the Offline Analysis 

application and the Protocol Editor.  

The image acquisition is primarily controlled with the controls shown in Figure 7.  

 

   

Figure 7: Acquisition controls 

 

3.1 Snapshot 

The Snapshot function acquires one image with the current exposure settings and with the 

currently selected light source and keeps it in memory. The light source will be triggered in this 

mode, like in any protocol, thus minimizing the photo toxicity and photo bleaching. The image 

can be saved by pressing the Save/Disk icon  in the toolbar.  

3.1.1 Panorama 

The Panorama option is only valid for the Snapshot function and is only available on systems 

with a motorized stage like the iMIC or imaging systems with the TILL Stage. 

If this option is enabled, by setting the check mark, a series of adjacent images either 2 by 2 or 3 

by 3 images is taken. This allows a larger field of view without changing the objective. The size 

of the Panorama can be set in the Acquisition > Panorama Size menu.  

All navigation features like Move and shoot are available in the Panorama mode. In the Grid 

view the grid spacing will also be adjusted to represent the larger field of view. 
 

3.2 Live 

The Live function displays a series of images with the current exposure and light source settings. 

In the Live mode the light source in use will be triggered to avoid unnecessary exposures that 

would otherwise lead to photo bleaching of the samples and photo toxicity in the sample. The 

acquisition of images in Live mode is stopped by pressing the stop button. The last displayed 

image can be saved by pressing the Save/Disk icon in the toolbar (see chapter 3.3.1.)  

 

Hint: To save a series of images the Time lapse protocol (see chapter 3.9) needs to be used.  

 

Information:  
Before taking images with either Snapshot or Live the following device settings should be 

checked: 

- Exposure time 
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- Selected camera 

- Camera settings like gain, binning chip window 

- Selected light source 

- Light source settings like filter position/wavelength, intensity, bandwidth 

- Filter slider position 

3.3 Saving images 

Pressing the Disk icon  in the toolbar saves the currently displayed image to the disk. The 

image that will be saved can be an image taken by using the Snapshot function or the last image 

of a Live image sequence. 

3.3.1 Saving options  

Saving options for the images depend on image streamer that is used to save images. Selecting 

and changing the image streamer is described in detail in chapter xyz. 

3.3.2 Offline Analysis saving option 

The acquired data is send to the Offline Analysis application and is stored in one of the available 

Experiment Sets. It is possible in LA to select one existing Set where the newly acquired data 

should be stored and it is also possible to create new Experiment Sets. 

3.3.3 LA Browser saving options 

The acquired image is sent to the LA Browser and displayed in a window. The image is also 

stored in the default folder set in the LA Browser. The default folder in the LA Browser can be 

set in the Extra > Preferences > General menu. Change the value of the Working path panel. 

3.3.4 LA TIFF and TIFF ImageJ saving options 

If the user selected the TIFF or TIFF ImageJ streamer the acquired image will be either saved to 

the disk using the default path or the user will be asked to select the destination folder in a dialog. 

Toggling the behavior, using the working directory or asking for a destination folder to save the 

image, is done in the Config > TIFF ImageJ streamer or Config > TIFF Streamer dialog. 

If Ask for save directory is set to “true” the user will be prompted to select the directory when the 

Disk Icon was pressed. If the value is set to false the directory in Autosave path will be used to 

save the images. 

3.4 Experiments  

The experiment list contains items in up to three categories (Figure 8), depending on the hardware 

configuration (e.g. TIRF and/or FRAP experiments) and the purchased software modules.  

 

If the Protocol Editor module was purchased the first entry in the list is the Protocol Editor item. 

Selecting this item will open the Protocol Editor window where workflows built from multiple 

experiment items can be created and edited.  

 

The second category holds basic experiments, like Time Lapse, Tile or Z-Stack. The items of this 

category can also be found in the Protocol Editor and used there to build more complex 

experimental workflows.  
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In the third category are the advanced protocols, which are partially built from multiple basic 

experiments or are special protocols only available with special hardware (e.g. DynamicFRAP). 

 

  
Figure 8: Example of available experiments  

 

Selecting one of the items in the list will open the secondary experiment panel or in case of the 

Protocol editor an additional floating window. 

3.4.1 Show and hide the experiment panel 

The secondary experiment panel can be hidden or shown by pressing the button with the double 

arrow on the right side in the acquisition control panel. This is particular useful if the settings of 

an experiment are done and acquisition should start to maximize the viewing area for the acquired 

images. 

3.4.2 Experiment parameter check button 

To validate the parameters of an experiment (basic and advanced) or a workflow created with the 

Protocol Editor the green check button to the right of the experiment list can be clicked (Figure 

9). The experiment or workflow will then be check and the minimum time for certain operations, 

like the cycle time, will be optimized. 

 

 
Figure 9: Location of the Experiment parameter check button. 

3.5 Acquire 

The Acquire button  starts the execution of an experiment or custom workflow created in 

the Protocol Editor and saves the acquired images do the disk using the currently selected 

streamer. The Acquire button changes its appearance during the acquisition into a Pause button, 

which allows suspending the current experiment by the user and resume it when needed. 
 

3.6 Play/Test run 

The Play or Test  button with the green triangle also starts the execution of an experiment or 

workflow but in contrast to the Acquire button the acquired images are NOT saved to the disk! This mode 

is useful to test the experiment settings before running the real experiment. 
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3.7 Stop 

The Stop button is used to stop the acquisition of images in Live mode or to stop the execution of 

experiment and workflows early.  
 

3.8 Selecting and controlling a light source 

The controls for the light sources are located at the bottom of the LA application window.  

The light source control has up to three areas, where the user can adjust the parameters for the 

selected illumination mode. 

In the top area is the title bar of the control. In the title bar are several control located from left to 

right 

: 

 The collapse/expand triangle for showing or minimizing the light source control 

 The “Mode” list, where the user can switch between different available illumination 

modes (Widefield, TIRF,..) 

 The “Light sources” if multiple are available for the selected illumination mode, e.g. 

PolychromeV, Lasers, LEDs. 

 The “On” switch where the currently selected light source can be switched on 

permanently. The light source then will be turned on independent of any experiment or 

protocol.  

 The light source “Preset”-control on the far right allows switching between multiple, user 

defined presets and managing them. 

3.8.1 Polychrome V 

Changing the Wavelength, Intensity (optional) and Bandwidth (optional) of the Polychrome V 

from the Live Acquisition software is done in the Light Source control panel. 

 

 
Figure 10: Light source control panel for the Polychrome V 

 

 

The graphically control can be moved by a left mouse click and a drag.  There are three yellow 

circles in the graphical spectrum slider.   

 

 Clicking and dragging in a vertical fashion on the topmost one will change the intensity. 

 Clicking and dragging in a horizontal manner on the middle one will change the 

wavelength. 

 Clicking and dragging in a horizontal fashion on the lowermost one will change the 

bandwidth. 

 

Intensity, wavelength, and bandwidth can also be edited directly with the roll bar. 
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3.8.2 Laser Line Combiner 

The Laser Line Combiner Control consist of sliders for changing the intensity of each laser line 

individually. Each laser line can be “blanked” by clicking on the checkmark “blank”, by this the 

user can turn individual laser lines on and off without changing the intensity. 

 

 
Figure 11: Laser line combiner control for Live view and Snapshots 

3.8.3 Oligochrome 

 

 
 

3.9 Basic acquisition: A “Time Lapse” experiment 

The Live Acquisition Software provides some pre-defined experiments that can be started right 

away without utilizing a protocol editor. 

In this chapter an introduction is given on how-to acquire a time lapse experiment with the 

following parameters: 

 one channel 

 a series of 100 images 

 With a frequency of 1Hz or an image every second 

 a Polychorme V as light source 

Opening the panel for the parameters of a time lapse experiment can be done by going to the 

menu  Acquisition > Time Lapse (Figure 12: Selecting the Time Lapse experiment in the 

“Acquire” menuFigure 12). 
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Figure 12: Selecting the Time Lapse experiment in the “Acquire” menu 

 

A second row of panels, located to the right side of hardware control panels, the will open in the 

LA software (Figure 13). This panel is divided into three sections from top to bottom: 

 

- Experiment Presets: Manage presets of experiments for frequently used workflows for 

more details see chapter (3.10). 

- Time Lapse: This is the area where the parameters for the image acquisition will be set. 

- Online Analysis: Depending on the parameters set in the experiment, LA will show 

different options for online evaluation like Kinetics, RATIO and FRET (please see 

chapter 6 for more information). 

 
Figure 13: Experiment parameter panel open 

 

The Time Lapse section provides the input for entering the parameters of our Time Lapse 

experiment. Going from the top of the Time Lapse area to the bottom we have a selector for: 

 

-  Switching between a single (1 Channel) and a dual (2 Channel) acquisition. By default the 

single channel option is selected and we leave it like this. 
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- The “Light Source” selector. Here we can choose a light source from the installed ones 

on our system. For our planned experiment we select the Polychrome V (or the 

Oligochrome) from the list. 

- Below the light source selector on the left side we can enter the parameters for first 

channel. For two channel experiments a second column will be displayed with the same 

parameters. 

- If we have chosen the Polychrome V as light source the first parameter for Channel 1 from 

the top is the “Wavelength” that we want the Polychrome to generate when an image is 

acquired. This wavelength is depended on the fluorescent dye, which is used in the 

experiment (e.g. Fluo-4 and Oregon Green BAPTA can be excited at 488nm). 

     OR 

- If we have chosen the Oligochrome as light source the first parameter in for channel 1 is 

the filter position of the Oligochrome. With this filter the excitation wavelength is chosen. 

- The next parameter is the “Exposure time” for the image. This parameter applies for both 

the Polychrome and the Oligochrome again. By default the exposure time is taken from the 

Live/Snapshot setting but can be changed. Longer exposure times mean brighter images 

but can lead to saturation if chosen too long. 

- The next parameter is the “Cycle Time”. The cycle time is the time between the start of 

two images in contrast to a delay which is the time between the end of one image 

acquisition and the start of the next. In our example a frequency of one Hertz is desired, 

which means an image is taken every second.  

Hint: If the cycle time control is grayed out and cannot be edited, please have a look at the 

bottom of the Time Lapse panel if the option “Use minimal cycle time” is checked. To edit 

the cycle time this option has to be un-checked. 

 

- The last parameter that needs to be set is the “Loop Count”. With this parameter we tell 

Live Acquisition how many image we want to acquire. In our case we want to acquire 100 

images. 

To acquire the one channel Time Lapse experiment the “Record” button  has to be 

pressed.  

In Figure  
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Figure 14: Screen shot of the example time lapse experiment with a Polychrome V light source 

 

3.10 Toggle in the Image View 

In RATIO experiments it is often useful to show the calculated RATIO image instead of the 

individual channels. The LA software allow switching between the normal display where the 

images are displayed in their order in that they are acquired or the RATIO image display where 

the calculated RATIO image will be shown. 

Switching between normal and RATIO image display is either done by selecting the menu item 

View > Switch to/from Float View or the respective icon in the toolbar. 

 
Figure 15: View options for toggleing the image display from and to the RATIO view 

3.11 Experiment Presets 

The Experiment Presets allow the users to save and recall frequently used experiment settings. 

This allows recalling experiment presets for RATIO, multi-channel or Z-Stacks. The saved 

presets are linked to the experiment; this means you will only see the presets in the experiment 

where they are created. 
 

3.11.1 What is saved in an Experiment Preset? 

A Preset saves all parameters of the active experiment like: 
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- The selected light source (if it is selectable in an experiment) 

- Light source parameters (Wavelength, intensities,…) 

- Cycle times 

- Loop count 

- Number of z-planes 

- Step size of the z-stack 

- Type of analysis (Kinetic,  RATIO or FRET) 

- FRAP ROIs and their parameters (bleach time, line count etc.) 

- Parameters of the analysis like thresholds, algorithms and channel assignment 

 

However, a preset does not save the “normal” regions of interest (ROIs), only the FRAP ROIs. 

3.11.2 Example 1: Saving a single channel Time-Lapse experiment. 

 

3.11.3 Example 2: Saving a two channel Time-Lapse for FURA-2 experiments. 

 

 

3.12 Finding the sample on an iMIC system 

The TILL Photonics iMIC is a digital microscope that has no eye-pieces anymore. Therefore the 

procedure of finding the sample is different from traditional microscopes. 

 

The eye pieces are replaced by the camera and the software and the manual z-drive is replaced 

with the mouse-wheel on iMIC microscopes. 

There are several advantages to this approach, one being the ability to turn the light source on 

only if an image is taken. This exposes the cells to less light than the approach on traditional 

microscopes, where the user will turn on the light source permanently while browsing the sample 

by looking through the eye pieces. 

 

Here’s a short list of the advantages of using a camera and software instead of eye pieces for 

browsing the sample: 

 

- Less photo bleaching 

- Color mapping (applying different palettes) 

- Adjustment of brightness and contrast in software manually or with auto contrast 

-  

Having all axes motorized has several advantages for the user like setting position markers to 

mark interesting spots in the sample and to run experiments/protocols on each of the position 

markers. 

However, as there are no physical knobs on the microscope anymore to move the axes of the 

stage, the software needs to provide at least equivalent functionality. 

This is what the LA software was made for from the very first release, it provides a broad range 

of tools for different workflows in navigating the sample: 
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- Move and Shot 

- Overview Scan with the option to do sub scans 

- Stage Navigator with Overlays and Grid view 

- Software Joystick mode 

- Click and Drag – Mode 

- Support for USB Joysticks 

- Using the keyboard 

 

3.12.1 Recommended frame rate for browsing the sample 

To have a smooth impression while browsing the sample we recommend a frame rate of at least 

10Hz while browsing the sample. 

There are cameras that cannot achieve this frame rate in full frame mode. We recommend using 

binning, vertical and horizontal, to increase the frame rate. This also allows reducing the exposure 

time and in turn bleaches the cells even less. The xy-resolution is decreased a bit but should in 

normal cases still be more than good enough to find the sample. 

Bleaching is usually not an issue with this method as the LA software will turn the light off is no 

image is acquired by the camera. In the end there is less photo bleaching that browsing the sample 

with oculars where the light is permanently on. 

 

3.12.2 Bringing the sample into the field of view 

There are multiple ways in bringing the sample in the field of view. To travel large distances, the 

easiest way is to use the Navigator. By clicking into the navigator the xy-stage will move there. 

Other ways are the keyboard cursor keys or one of the supported joysticks. 

 

3.12.3 Adjusting the Z-Position: The Z-Control 

Like on conventional microscopes one of the hardest parts is to find the focus position. If the 

standard insets for the iMIC Prior stage are used or the integrated stage, the focus is usually found 

between 18 and 20mm of the iMIC z-drive. 

Using a lower magnification objective (10x or below) makes it easier to find the focus. 

 

3.12.4 Changing filters/filter cubes 

On iMIC microscope systems the user can change the filter cubes from the software. There are 

button or list controls provided for this in the Filters panel of LA (). Here the user can also find 

controls for additional filter wheels or the Andormeda filter wheels and dichroic slider. 

 

 
Figure 16: Filter and dichroic slider control in LA 
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3.12.5 Overview Scan 

Once the focus position is found, LA offers a unique and very convenient way of browsing the 

sample with the Overview Scan. 

The Overview Scan acquires images in a rectangular previously defined scanning area and creates 

one large tiled image from the acquired ones. 

The Overview Scan allows zooming into the image and to inspect the acquired images without 

acquiring new ones and thereby preventing the sample from bleaching while browsing the 

sample. 

An Overview Scan is started by going to the Menu: Navigation > Overview Scan… 

If an Overview Scan has already been acquired and the window was close in the meantime, it can 

be re-opened again without rescanning the area by the View > Overview Scan menu item. 

Zooming is done with the Computer mouse wheel. 

Moving the images in x and y direction in the window by clicking into the image area and 

holding down the mouse button and moving the mouse in x and y. The movement will stop once 

the mouse button is released. 

 
Figure 17: Overview Scan window. 

 

 

The controls in the Overview Scan window allow executing the following functions: 

- zooming out to view the full width of the scanned images area 

- Toggling between full screen and windowed display mode 

- Saving an image of the currently displayed area 

- Toggle between navigation and sub scan mode 

- Run a sub scan on the selected area 

- Change contrast and brightness of the displayed images in the Overview scan window 

 

The scan area can be limited by creating new Navigator calibrations, please refer to chapter 10.  
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Furthermore the Overview Scan allows scanning sub areas of the sample. This can be done with 

the same magnification or if needed also with a higher magnification, to create higher resolution 

sub scans with a low resolution overview scan. 

 

3.12.6 Changing Objectives 

Changing objectives is done by clicking on the desired objective button in the Objectives panel of 

LA. This panel is the top most in the hardware control section. The buttons show the 

internationally standardized color coding for the magnification on top, then in the next row the 

magnification and NA and in the last row of the button caption the immersion medium. 

 

 

 
Figure 18: Objective changer 

 

The parameters of the objectives can be changed in the Config menu. In case of an iMIC system 

the objectives parameters can be found in Config > iMIC > Objectives Configuration. If a manual 

objective changer has been configured in an imaging system the objectives parameters can be 

changed in the menu Config > Manual Objective Changer. 

3.12.7 Using the Keyboard for navigation 

The LA Software allows using the arrow keys to move the stage frame wise in the corresponding 

direction. Additionally to change the z-Position can be changed with the Page-Up and Page-

Down keys. For a list of all available keyboard short cuts please refer to chapter 2.2.1.2 

3.12.8 Moving the stage with the mouse 

In the LA Software it is possible to navigate with the computer mouse only. Changing the Z-

Position is done with the mouse wheel. Be reminded that the image display needs to be “active” 

and the mouse needs to be hovering above the image display. Otherwise other graphical controls 

might react to the mouse wheel and change their values. 

3.12.9 Virtual Joystick 

The keyboard <X> key combined with the Mouse will act as virtual joystick.  As long as the ‘X’ 

key is held down when the mouse is in the Viewing Panel will ‘anchor’ a joystick icon on the 

Viewing Panel.  If the ‘X’ cursor is continued to be held down while the mouse is moved then the 

mouse movements will act like a joystick centered on the ‘anchor’ position.   

 

The longer the mouse is held and the farther it is moved speeds up the rate at which the XY 

position is changed.  Releasing either the left mouse button or the ‘X’ key will deactivate the 

joystick mode. 

 

3.12.10 Using a Joystick to move the stage 

If a HID (Human Interface Device) USB Joystick is connected to the computer, this Joystick can 

be used to move the xy-stage. Enabling the USB joystick in the software requires to activate the 

driver in LA in the menu Config > Start HID Joystick. 
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The user can then select between two modes, continuous movement or camera frame wise, by 

checking or un-checking the menu item Navigation > Joystick mode 

 

3.12.11 Full Screen mode 

The Full Screen mode maximized the image display by hiding the hardware, light source controls 

as well as the menu bar. 

Entering the Full Screen Mode can be done by two ways:  

 

- either with the key combination “Alt-Enter”  

- By the Menu item View > Full Screen. 

Leaving the Full Screen mode is achieved by: 

 

- pressing the Alt-Enter key combination  

- the Exit button in floating palette window. 

In Full Screen mode it is possible to use many navigation functions like the mouse wheel, the 

joysticks and the keyboard for browsing the sample. 

The context menu is also available, where the z-step size can be change or the Auto focus can be 

invoked. ROIs can also be modified but not created. 
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4 Camera controls 

4.1 General 

Most cameras come with advanced controls for a fine grained control of camera acquisition 

parameters. Depending on the camera manufacturer and camera model different options are 

provided by the Live Acquisition software. 

 

 Binning 

 Chip-Window 

 (EM) Gain settings 

 Temperature settings 

 Vertical and/or horizontal shift speeds 

 Voltage clocks of Camera ADCs 

 Fan speed control 

4.2 Camera properties 

The camera properties panel holds the most frequently used controls for camera operation. These 

are the option to change the chip-window of a camera, the binning value and the EM-Gain setting 

for EM-CCD camera. 

With the chip-window feature the user can restrict the area where the camera is acquiring only a 

sub frame/area. By this the user can increase the speed of the acquisition and reduce the amount 

of data generated during the experiment. Usually the speed increase is only dependent on the 

height of the chip-window and not on the width.  

The binning feature of the camera has two advantages. The first advantage is that by using the 

binning the amount of image data is reduced and thus leads to a profound speed increase of the 

acquisition rate of the cameras. 

The second advantage is that by using the binning multiple pixels of the camera are read out in 

one step. Without binning each pixel would have been read out by the camera electronics and 

each readout process would add some noise. With binning multiple pixels are read out once and 

therefore only adding once the readout noise to the pixel value! 

The only drawback of binning is the reduction in resolution. Depending on the camera model the 

user might change the binning values independently (e.g.: 1x2, 2x8) or symmetrical (2x2, 

4x4,…).  

 

 
Figure 19: Camera properties panel 
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4.3 Advanced Camera Controls 

In the advanced camera controls the user will find camera specific controls and options. A typical 

example is the EM-gain setting on the EM cameras, that is not available on interline chip 

cameras. Other features include control for the cooling system if available or selection of the 

read-out speed and register. 

 

 
Figure 20: Advanced camera control window 

4.4 Camera selector 

The camera selector control is only available if multiple cameras have been configured in the 

device configuration. Changing the camera by selecting it from the drop down list (Figure 21: 

Camera selector) will make its properties and advanced properties available. 

 

 
Figure 21: Camera selector 

 

Additionally the tube factor in the iMIC configuration menu (Config > iMIC with Imaging 

Control Unit > Filter and Axis) will change. This allows having different camera port 

magnifications if needed. 

 

Hint: to change the tube factor for a camera, the desired camera has to be selected first. 

 

If the camera selector is collapsed it will show the name of the selected camera in the title (Figure 

22). 

 

 
Figure 22: Camera selector showing the name of the selected camera when collapsed 

4.5 Assigning multiple camera to the ports on the iMIC 

If the LA software detects a camera port switch in the iMIC it will offer a dialog where the user 

can assign the available cameras on the system to the three available positions of the iMIC 

camera port switcher. 

The dialog for the camera to port assignment is located under Config > iMIC with Control Unit. 

Switching between the installed cameras is done by selecting the desired one in the Camera 

selector (Figure 21). 
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Figure 23: iMIC Camera Switcher dialog 

 

4.6 Simultaneous acquisitions of images with two cameras (DualCam) 

This feature is an optional module for the Live Acquisition software that allows acquiring images 

from two cameras simultaneously. Both acquired images are displayed in a split, overlay or ratio 

view. These view options are the same as for FRET images when using an iMIC Dichrotome. 

In LA it is possible to select the individual cameras or to use them simultaneous. This selection is 

done with the camera selector (Figure 21). 

 

To configure a DualCam setup in LA the user has to use the “Multi Camera” device in the device 

configuration dialog. 

Opening the properties window of the Multi Camera Device (Figure 24) requires the user to enter 

the trigger connection (usually to the ICU “Camera sync Out” connector). 

 

 

 
Figure 24: Multi Camera device properties dialog 
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5 Image processing 

5.1 Applying color palettes to gray scale images 

 

In Live Acquisition the user can change the color palettes by selecting the desired palette in the 

menu Display > Palette. 

 

 
Figure 25: Menu to change the color palette 

 

Alternatively the palette can be changed by “right clicking” onto the color bar on the right in the 

Live Acquisition window. 

 

 
Figure 26: Context menu to change the color palette 

 

5.2 Advanced color palettes options 

Additionally to the different color palettes the user can choose between three palette options: 

 

Classic: This is the standard mode for the color mapping. The color palette is unmodified 

and covers the full dynamic range of the camera or the adjusted dynamic range set by the 

user manually (brightness and contrast) or by using the Auto Contrast functions. 

 

Saturation: This mode will display the maximal and minimal value of the dynamic range 

from the camera in different colors. This allows to observe if the camera chip is saturated 

or in case of cameras with baseline clamping if the clamp value is too low and therefore 

cuts of signals from the sample. 
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Min Max: Here the minimum and maximum value of the palette will have different colors 

to make the values stand out. This min max also works with manual adjustment of 

brightness and contrast as with the Auto Contrast features. If the background correction 

feature is enabled the mean intensity values of the background region will be taken into 

account for the minimum calculation, too.    

 

5.3 Changing contrast and brightness 

Contrast and brightness are controlled with the control on the right to the displayed image (Figure 

27). 

 

 
Figure 27: Auto scale - Auto Contrast 

 

These scales are each composed of three controls. 

 

 Maximum – Appears at the top of the scale 

 Auto scale – The stylized ‘Auto’ Button in the top of the scale 

 Minimum – appears at the bottom of the scale 

 

Maximum and minimum each consist of the following component(s): 

 

 A roll bar for sequential increment/decrement of the parameter 

 A limit control (a dotted line in the intensity scale) to change the values of the parameter  

 

The vertical scaling bar has a box on its upper and lower end, in which one can manually enter 

the max and min value to be displayed. 

 

 
Figure 28: Interactive intensity range/brightness scaling 

 

Within the spectrum there is a horizontal line on both ends. Clicking into the spin buttons moves 

up and down stepwise; continuously clicking into a spin button causes a gradually accelerating 

continuous move. Dragging the horizontal line to a given position in the spectrum chooses this 

position as the upper/respective lower limit. There are two ways to extend the reduced display 

limits:  
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The auto scale button is a configurable button. With a right click on the button you have the 

ability to set the new auto scaling min and max values. 

 

 Clicking on auto scale sets max min values to the current ones. Double Clicking turns a 

continuous auto scale on. Clicking again freezes the current value and turns auto scale 

off; 

 Single Clicking on auto scale executes a single auto scale and scales all subsequent 

images within the one time determined boundaries; 

 

The parameters in the in the scaling controls can be reset by right clicking the mouse in their 

respective windows. 

 

There is also a button labeled ‘Area’ which when clicked allows the mouse left button to set a 

rubber band bounded border inside the Viewing Panel.  When the left mouse button is released 

then the auto contrast will be triggered and will use the area inside the bounding box as the 

determination criteria of how to set the contrast scale. 

 

This ‘ROI’ button has a second option. If it is double clicked before the bounding box is drawn 

then the bounding box remains semi-permanent and will continue to be used for contrast 

calculations. 
 

5.4 Auto contrast 

The Auto Contrast feature will optimize the image quality for the display. The original image data 

will not be modified when saved to the hard disk. There are three ways to enable the Auto 

Contrast: 

 The first way is to go to the menu Display > Auto contrast (Figure 29), that will enable 

the feature permanently until the item in the menu is deselected again. 

 The second method is to enable the feature by using the context menu by right-clicking 

onto the currently displayed image. 

 

 
Figure 29: Enable Auto Contrast from the menu bar 

 

 The third way to enable the Auto Contrast feature with the button above the color bar 

control on the right side of the LA window. This button has three states: off, once and 

permanently. 

5.5 Background correction 

Background correction is meant for wide-field microscopy where a certain level of background 

fluorescence is unavoidable. Background correction in the Live Acquisition software reduces the 

overall intensity of an image by the mean value of the background correction ROI. 
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Drawing a ROI for the Background correction feature is done either form the context menu of the 

image display or from the menu Display > Draw new Background (Figure 30). Alternatively the 

drawing of a new background correction region can be invoked from the context menu; 

 

 
Figure 30: Menu item for drawing a background correction ROI 

 

5.6 Scale bar 

The scale bar can be enabled from the View menu View > Sow Scale Bar. To display the correct 

length the configuration and calibration of the system has to be done first. The Scale bar uses the 

properties of the currently selected Objective (magnification and correction factor), the pixel size 

of the camera and the tube factor from the microscope configuration to calculate the correct 

values. 

The Scale bar can be configured by the Config > Image Scales configuration menu. The Image 

Scales dialog allows to enable/disable the scale bar and also to change its size and orientation 

(Figure 31). 

 

 
Figure 31: Scale bar options dialog 

 

Hint: to make proper use of the scale bar in imaging systems without an iMIC, a manual objective 

changer can be configured. 

5.7 Pixel value 

The Intensity value of a given pixel in the image can be inspected by moving the mouse cursor 

over the desired pixel. The intensity value of the pixel under the mouse cursor is then displayed 

right hand side in the status bar at the bottom of the LA window (Figure 32). 

 

 
Figure 32: Pixel intensity value und the mouse cursor in the image 

 

5.8 Histogram 

The Histogram can be shown by using the menu item View > Histogram or the histogram icon in 

the toolbar. I show a normalized gray-value distribution and displays it besides the color-bar. 
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Optionally the histogram calculation can be restricted to a ROI. The ROI can be created by using 

the menu View > Histogram ROI. After selecting the menu item the user can draw a rectangular 

ROI on the image display without further actions. 

 

 
Figure 33: Toggle the histogram display from the toolbar 

 

 
Figure 34: Histogram display between the image and the color bar. 

 

  



                         Live Acquisition Software Documentation v2.2.0 

44 

 

6 Offline Analysis 
The Offline Analysis Application allows displaying and managing data and to run analyzes 

offline. It also features an extensive Meta data info panel where a relevant data about the acquired 

images and sequences can be displayed. There are also the options to export the images and/or 

open a selected file in ImageJ/Fiji.  

 

We preserved the workflows and the look and feel of the Live Acquisition software as far as 

possible and where applicable to keep the learning curve for this application as flat as possible. 

You will find yourself familiar with the application if you already know the Live Acquisition 

software. This applies especially for the menu structure, the tools in the toolbar and the analysis 

panels. 

 

6.1 Screen layout 

There are four main areas in the Offline Analysis application. 

 

- On top there’s the menu bar. 

- On the left is the “Set” management where all the image data can be organized 

- In the center of the application window the display area for images and the related 

controls for navigating in the image data set and the toolbar for ROIs, the graph window 

and zooming. 

- Located on the right in the main window are the panels for analysis functions and 

information/meta data display. 

 
Figure 35: Main window of the Offline Analysis application 
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6.2 Data management with “Experiment Sets” 

The Offline Analysis application provides functions for grouping image sequences into data sets. 

This allows grouping of multiple acquired image sequences that belong to a series/type of 

(biological) experiments. The Groups/Sets can be collapsed or expanded by clicking on the small 

triangle in front of the name. This behaves like the directory tree view in Microsoft’s Windows 7. 

Analysis data, here graphs, are stored as child item of an image sequence and can be recalled with 

the used ROIs and the graph by double clicking on them. 

6.2.1 Creating a new Experiment Set  

Creating a new Experiment Set is done with the button “New Experiment Set” on top of the 

Experiment Set tree view. 

All Experiment Sets in the Offline Analysis Applications are also visible from the Live 

Acquisition application and can also be created there before an experiment is acquired.  

 

6.2.2 Deleting an Experiment Set 

Deleting or renaming an Experiment Set is done through the context menu. 

 

Warning: Deleting an Experiment Set is done through the context menu item “Delete”.  

Be aware that this will also delete all enclosed image data! 

 

6.2.1 Renaming an Experiment Set 

An Experiment Set can be renamed by using the Edit command from the context menu. To 

rename an Experiment Set it must be selected. The Edit command will open a dialog where the 

name of the Experiment Set can be changed. To apply the name change press “OK”. 

 

6.2.2 Moving (Cut&Paste) acquired image sequences between Experiment Sets 

The acquired images or image sequences can be moved from one Experiment Set to another with 

the “Cut” and “Paste” commands from the context menu.  

Selecting a sequence by clicking on it allows using the “Cut” command in the context menu. The 

context menu is opened by pressing the right mouse button. 

Hint: It is not necessary to open the file that should be moved by double-clicking on it. 

The cut image sequence can then be “pasted” to another Experiment set by selecting the 

experiment set and selecting the “Paste” command from the context menu. 

 

Summary for moving an image sequence: 

- Select the desired image sequence by clicking on it (left mouse button) 

- Open the context menu for this item by pressing the right mouse button 

- Select the “Cut” item in the context menu 

- Select the Experiment Set where the image sequence should be moved 

- Open the context menu for the Experiment Set by pressing the right mouse button 

- Select “Paste” from the context menu 

 The image sequence is then moved to the other Experiment Set 

 



                         Live Acquisition Software Documentation v2.2.0 

46 

 

6.3 Data display and Movie player 

The center of the Offline Analysis application window is used to display the image data. This 

area can be divided into three sub regions. On top resides the tool bar which holds icons for 

creating and managing Regions-Of-Interest (ROIs; see chapter 7.1), toggling the Graph window 

and icons for zooming in and out of the images. 

In the middle is display for the images and there are also the same controls for adjusting the 

brightness and contrast of the image as well as applying color transfer functions (color mapping 

through false color palettes) like in Live Acquisition. For further reading please refer to chapter 

(0). 

At the bottom of the center area the control for navigating the image data are located (Figure 36). 

 

 
Figure 36: Movie Player and image navigation controls 

 

The Movie player controls allow replaying a time series at different speeds. Further options are to 

move to the next or previous frame or to move to the beginning or end of a sequence. 

6.4 Toolbar 

The toolbar is located on top of the image display area. The toolbar contains functions for 

creating and editing ROIs, displaying the Offline Graph window and options to zoom in and out 

of the image 

6.4.1 Drawing ROIs 

The Offline Analysis Application provides the same ROI functionality as the Live Acquisition 

application. For a detailed description of the ROI managing capabilities please refer to chapter 

7.1ff. 

By default all ROIs that where draw in the Live Acquisition software are also available in the 

Offline Analysis application if the image data is opened there. 

6.4.2 Show Analysis Graph window 

With the Graph button it is possible to toggle the visibility of the Offline Graph window. The 

offline Graph window has the same options like the Graph window of the online analyzes. A 

detailed description of the Graph window functionality can be found in chapter 7.5 

6.4.3 Zoom options 

The toolbar has a bunch of buttons to zoom in and out of the displayed images or to fit the image 

to the available space in the application window. A detailed description of the functions can be 

found in chapter  

6.5 Analysis Tab – Offline analyzes 

Here are all the controls that are needed for running an analysis, kinetics, RATIO or FRET, on an 

existing image data set. As the layout of the control and all options are the same as in Live 

Acquisition, one will find itself in a familiar place. At this point please have a look at the 
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6.6 Information Tab 

The Information Tab shows the Meta data of the currently open image sequence. The Meta data 

of the sequence is divided in to four categories: 

 

- Experiment: Here the parameters of the experiment can be found. This includes used 

camera, light source, number of frames, channels, planes. 

- Images: In this category the data of all images is shown as a table. The shown parameters 

for each image include x,y,z position, running number, time stamp. This data can be 

selected either with the mouse or with Ctrl-A (selects all cells) and copied to the clipboard 

via the Ctrl-C shortcut for further processing. 

- Hardware: This category shows the system configuration (hardware), which was used to 

acquire the currently open image sequence. This includes information like the vendor 

specific device version strings. 

- LA: This category shows the LA software specific data: This includes calibration data for 

devices like the Polytrope and Yanus. 

An example on how the information tab looks like is given below (Figure 37). 

 

 
Figure 37: Information tab examples for the Experiment and Hardware subcategory 
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7 Advanced image analysis 

7.1 Pixel Value 

These values can be found on the right side of the status bar at the bottom of the main window. 

For more information, please refer to chapter (5.7).  

 

 
Figure 38: Pixel intensity display in Offline Analysis 

 

7.2 Regions Of Interest (ROI) 

Regions Of Interest are user defined smaller parts of the acquired image. These parts or regions 

can be ellipses, rectangles or polygons. 

7.2.1 Drawing ROIs 

To define or draw a ROI the user can select different shapes from the tool bar. For analysis 

functions the rectangle, ellipse, polygon and freehand tool can be used (from left to right). The 

spot and line tools can only be used in FRAP experiments. 

Once the desired ROI shape has been selected the user can draw multiple ROI of the selected 

shape in a row. To stop creating ROIs the user has to select the Arrow/Mouse cursor icon in the 

tool bar. 
 

 
Figure 39: ROI drawing tools in the main toolbar 

 

When the Arrow tool is selected the user can manipulate the dimensions of the ROIs by dragging 

the outline. 

 

7.2.2 Region (ROI) Manager 

The ROI manager allows manage ROIs and to change their properties. The ROI Manager window 

is opened from the menu ROIs > ROI manager… . 

 

 
 

Figure 40: ROI Manager Window 

 

On the left hand side of the ROI Manager window the list of all currently drawn ROIs is shown. 

On the top of the window besides the ROI list a toolbar (Figure 41: Toolbar in the ROI Manager 

window) is located that holds some icons for managing the ROIs. 
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Figure 41: Toolbar in the ROI Manager window 

 

Tools available for managing ROIs: 

 Go to: Pressing this button will move the stage to the position where the ROI was 

drawn. This feature is only available on systems with a motorized xy-stage. The ROI 

position needs to be Stage Relative. 

 

Send to back & Send to front: Allows changing the order of the ROIs. This is 

usefull if one smaller ROI is hidden by a bigger one that was draw later. In this case it is 

possible to move the “hidden” ROI to the front an make it selectable again. The order f 

the ROIs has no effect on the analysis features in Live Acquisition. 

 

Delete: This deletes the currently selected ROI. Selecting the ROI can be done in the 

ROI list of the ROI Manager window or directly in the image display area of Live 

Acquisition. 

 

Delete All: This will delete all ROIs form the list after a safety dialog is show to 

confirm this action. 

 

Editing the properties of a ROI is also possible in the ROI Manager window. 

 

The following ROI properties can be edited: 

Role: For analysis purposes it might be necessary to assign different Roles to the ROIs. 

Foreground is the default Role for all newly created ROIs. Background is used by 

analysis functions to subtract a mean value in some calculations. 

  

 Name: This allows editing the ROI name. By default the ROI name is created with a 

prefix “ROI” and the running number. 

 

Color: Each ROI gets a random color when it is created by the user. To change the color, 

click on the Color-button and select a new color for the ROI. 

 

Position: This option allows on systems with a motorized xy-stage to change the relative 

position of ROIs in the system. Selecting the Stage relative option will make the ROI 

position relative to the xy-stage which is useful if analyzes (Kinetics, RATIO, FRET,..) at 

multiple positions should be done. Selecting the Image relative option will position the 

ROI relative to the image coordinates; this is the default on systems without a motorized 

stage (e.g. Imaging Systems). This also allows user to create ROIs that are used in each 

position in multi-position experiments 

 

Hint: If the position option “Stage relative” is selected the ROIs will disappear if the stage 

is moved. Use the “Go to”-Button to move the stage to the ROI selected in the list.  
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7.3 ROI roles and how to change them 

In the LA software it is possible to assign different roles/functions to the ROIs. Changing the role 

of a ROI is done either in the context menu or in the ROI Manager.  

 

There are two default roles for ROIs in LA depending on the selected experiment: 

 

1) By default each ROI is assigned the “foreground” role if the experiment is not any of 

the FRAP experiments (Time Lapse, Multi channel, Snapshot, TIRF Epi,…). 

2) If the user has selected one of the FRAP experiments the default role of the newly 

created ROI will be “FRAP” and the ROIs are labeled accordingly. 

Available ROI roles: 

  

None: If this role is selected the ROI will not be used for an analysis function nor in a 

FRAP experiment as bleaching region. 

 

Foreground: This is the default for many experiments and with this role the ROI will be 

used to calculate the mean intensity of the pixels covered by its outline. 

 

Background: Setting the role of a ROI to “Background” will tell the analysis functions 

(RATIO, FRET and FRAP) to use this ROI for subtracting the mean intensity value of this 

ROI from certain parameters in the calculation of the RATIO and FRET values. 

If multiple “Background” ROIs are used Live Acquisition will use the pixel values of all 

background ROIs to calculate the mean intensity. This means that LA will sum up all pixel 

values of the background ROIs first and then divide the sum by the total number of the 

pixel in the background ROIs. 

 

FRAP: This option is only available if a FRAP experiment (FRAP or FRAP on Demand) is 

selected. Additional parameters for the FRAP ROI are set in the FRAP experiments them 

self, like bleach time and loop counts. During online analyzes (e.g. Kinetics) the FRAP 

ROIs can be used for analyzes, too. They will be available in the ROI manager and an 

Online Analysis panel is show below the FRAP experiment panels 

 

Hint: FRAP Regions will only show up in the ROI Manager if a FRAP experiment is 

selected! 

 

7.4 Starting an Online Analysis 

The available analysis functions can be found below the experiment parameters on a separate 

panel called “Online Analysis” (Figure 42) that is located below the experiment panel. 

Depending on the experiment parameters the list of available Online Analysis functions changes. 
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Figure 42: Online Analysis panel below an experiment panel 

  

7.4.1 Selecting the type of the analysis 

Depending on the number of channels in an experiment the LA software will offer a variable list 

of analyzes. 

 

Number of channels: 

 

• ONE: Always available is the Kinetic analysis that analyses the mean pixel value of the 

ROIs and plots these values vs. time. 

 

• TWO: If two channels are selected in an experiment the LA software will additionally offer 

a RATIO analysis for the experiment. The Kinetics analysis will then allow the user to select 

which channels should be analyzed. 

 

• THREE or more: If three or more channels are used in an experiment the software will also 

list the FRET analysis. However, if no license for the FRET analysis has been obtained a 

warning will be displayed no online analysis is possible. However, it is possible to edit the 

names/labels for the channels in the FRET analysis panel. 

7.5 The Graph-Window and its options 

This chapter describes the functionality and layout of the Graph window. The Graph window has 

the same feature set in the Live Acquisition and in the Offline Analysis application. 

Experiment panel 

Online analysis panel 
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7.5.1 Graph window layout 

 
 

 

The Online Analysis Results Window is divided into five areas: 

 

1) Toolbar: The Toolbar is located at the top of the window an contains buttons for saving 

the results and toggle some views (Time Markers, Captions of the Graph,…) and to zoom 

out of the graph. 

2) List of analyses: List of analyses done during an experiment. Usually this list has only 

one analysis listed, but if a “Marker Scan” experiment is done, the list will show the 

analyzes of each position from the scan. 

3) ROI vs. Time Plot: The Plot/Graph shows the mean values of the ROIs plotted versus 

time. If Time Markers are set during an experiment it will be displayed below the x-axis. 

Moving the mouse over a Time Marker will show a vertical line in the plot. 

4)  List of available ROIs: All ROIs that were used for the analysis are shown here. 

Checking and un-checking will toggle the visibility of the ROI traces in the Plot.  

a) Group by: Drop down list allows changing the way the ROIs are grouped, e.g by 

channel (Figure 44) or function.  

List of Time 

Markers set in 

an experiment 

ROI vs. Time Plot/Graph 

List of analyzes done 

per acquisition 

Toolbar 

List of available ROIs 

Figure 43: Online analysis graph window layout. 
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b) The color palette icon allows toggling between the original coloring and a new 

coloring schema where every ROI in each channel has a distinct color. This is usefull 

in multichannel experiments, where the color of the ROI is the same in each channel. 

a. Time Marker: List of the Time Markers set during an experiment are listed here 

and can be enabled/disabled by using the checkmark. 

 
Figure 44: ROIs grouped by channels in the Online Analysis Results window 

7.5.2 The toolbar buttons 

7.5.2.1 List of Analyzes 

This is a toggle button that allows showing or hiding the list of analyzes available. This is 

useful if image sequences are acquired that are done in one location. 

7.5.2.2 Save 

With this button the user can save the ROI mean values as CSV (comma-separated-values) 

or as native XLS (Excel) –files. This will only save the selected analysis from the list of 

available analyzes in case of multiple analyzes are available. 

7.5.2.3 Save All 

If multiple analyzes are available pressing this button will save all of the available analyzes 

regardless of the state (selected or not). 

7.5.2.4 Time Marker display 

With this button the visibility of the time markers, set during an experiment,  in the graph 

can be toggled. 

7.5.2.5 Graph legend 

Turning the legend on an off is done this icon in the toolbar of the Online Graph-Window 

7.5.2.6  Zoom out 

If the user has zoomed in to a particular region of the graph, he or she can un-zoom the 

graph fully by pressing this button without going to the context menu of the graph. 

 



                         Live Acquisition Software Documentation v2.2.0 

54 

 

7.5.3 Saving, coping, Printing of the Graph and Data 

The data in the graph window can be saved, copied to the clipboard or printed (Figure 45). 

The options are available from the context menu when “right-clicking” in the plot area. 

Saving the data point of the plot is done by using the Save icon and multiple Save icon in the 

Toolbar of the Online Analysis Result – window.  

 

 
Figure 45: Context menu items in the Online Analysis Results window 

7.5.4 Time Marker display 

The Time Markers are displayed as red arrows below the x-axis of the graph. If the mouse cursor 

hovers over one of the markers a vertical red line appears in the graph area. This makes it visually 

easier to see what happened at this Time Marker if multiple traces are shown in the graph. 

Time Markers can be shown or hidden by checking or un-checking them in the Time Markers -

List in bottom-right corner of the Online Graph-Window. 

 

7.5.5 Plot axis scaling 

The scaling of the y-Axis can be change from the context menu item Y Axis Options… of the 

graph (Figure 45). In the appearing dialog the user can select between manual scaling or 

automatic scaling. Choosing manual scaling allows setting the minimum and maximum of the y-

Axis. Choosing automatic will determine one of the values, minimum or maximum, 

automatically. 

7.6 Kinetics analysis 

This chapter describes how-to analyze the mean value of ROIs over time. The LA software can 

analyze the mean value of ROIs that are assigned as foreground regions. Regions that are 

assigned as Background will not be used for the calculation. Regions draw are for the first time 

are by default foreground ROIs.  

7.7 Ratio analysis 

The LA and OA software allows the analysis of RATIO experiments. It offers two algorithms for 

calculating the RATIO that are described in this chapter. 

7.7.1 Ratio algorithm 

By selecting the algorithm RATIO algorithm the LA and OA software calculate a RATIO image 

(32bit floating point) by dividing the pixel values from the same xy position from each channel. 
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Before the division is done the optional background values from each channel is subtracted from 

the pixel values of the corresponding channel. 

The mean value of the ROIs is calculated on the RATIO image. 

Pixels in the RATIO image with the value of zero will not be counted when the mean value of the 

ROIs is calculated. All values that might be below zero during the calculation of the RATIO 

values will be clipped to zero. This might happen when using background ROIs. 

 

 

 

 

 

 

 

 

 

 

Hint: Running a Kinetic analysis on an RATIO image (sequence) may result in different intensity 

values for the ROI mean values as the Kinetic analysis will count the zero intensity pixels for the 

ROI mean value calculation! 

This can be changed if the thresholds for the RATIO image calculation are set to zero! 

7.7.2 Ratio (integral) algorithm 

This variation of the RATIO calculation resembles the way that RATIO is calculated in 

Photometry setups. This algorithms is useful when working with samples where the signal to 

noise ratio is not optimal  the signal is relative weak. 

This algorithm first calculates the background value from the background ROIs in each channel 

and then subtracts this mean value from the mean value of the ROIs in each channel. In the next 

step the RATIO is calculated from the corrected (background subtracted) mean ROI values from 

both channels. The division is done with the mean values of the ROIs and not on a pixel basis! 

This works like having multiple photometry systems in the field of view. 

Optionally an RATIO image is calculated where the RATIO is calculated pixel by pixel like in 

the “normal” RATIO algorithm. 

7.8 FRET analysis 

 

This module is made for analyzing three channels FRET experiments where two excitation 

wavelengths are used to alternate excite the donor and acceptor expressed in one specimen. 

Donor and acceptor can be a pair for matching proteins like CFP (cyan fluorescent protein) and 

YFP (yellow fluorescent protein) or others (GFP, RFP, ...). 

Typically for a FRET experiment are two excitation wavelengths that excite both fluorescent 

proteins in a sequential manner as fast as possible to obtain three images by using the Dichrotome 

image splitter in the iMIC. The three channels that are used for the calculation of the FRET signal 

are the Donor, Acceptor and FRET channel. 

 

7.8.1 Description of available NFRET algorithms 
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The LA software offers three algorithms for calculating a normalized FRET image. The 

algorithms differ in the way the denominator is calculated. 

The Live Acquisition (LA) and Offline Analysis (OA) application calculate a FRET image pixel 

by pixle using one of the below formulas. When calculating the FRET image, the LA and OA 

software takes the xy-offset an background values (if assigned) into account. 

The mean value of the ROIs is calculated from the pixel values of the FRET image. All 

calculations are done with 32bit precision. 

 

 

N

backgroundIbtbackgroundIbtbackgroundI
NFRET

accaccdondonfret )(*)(*)(
 

 I fret  = Intensity of the FRET signal (excitation 440nm) of channel 2 

 Idon   = Intensity of the Donor-Emissionen (excitation 440nm) of channel 1 

 I acc = Intensity of the Acceptor-Emissionen (excitation 490nm) of channel 2 

 btdon = “Bleed-through” correction factor for the Donor 

 btacc = “Bleed-through” correction factor for the Acceptor 

 N = correction-factor for the normalization of the FRET signal 

 

The following formulas are used to calculate the denominator: 

 

Xia et al. : 

)(*)( backgroundIbackgroundIN accdon  

 

Gordon et al.: 

)(*)( backgroundIbackgroundIN accdon  

 

Youvan et al. (FRET in relation to the acceptor): 

)( backgroundIN acc  
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7.10 FRAP analysis 

7.10.1 Online FRAP analysis 

Live Acquisition allows to analyze the ROI mean value of FRAP ROIs during an experiment. 

However, this analysis does not allow running any fitting methods during the experiment; this has 

to be done offline in the Offline Analysis application. 

7.10.2 FRAP Analysis offline 

The FRAP Analysis module in the Offline Analysis application allows to calculate diffusion 

coefficients and a curve fitting with various formulas. 

The majority of the fitting formulas and other calculations are bases on the publication of Kota 

Miura from the EMBL in Heidelberg, Germany. 

 

It allows running extensive analysis functions on the acquired FRAP data that include bleaching 

correction, background subtraction and multiple fitting functions for calculating the important 

FRAP parameters. 

 

 
Figure 46: Parameters for the offline FRAP analysis 

 

 

7.11 Cropping of Image Sequences 

The Offline Analysis allows cropping new image sequences/stacks with the Crop Dimensions 

function. The Crop Dimensions allows copying parts of a multi-dimensional image sequence into 

a new sequence. This can be useful if only part of a z-stack is needed for visualization or 

deconvolution. 

The Crop Dimensions function can be found in the menu Processing > Crop Dimensions. 
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Figure 47: Sequence cropping dialog 

 

New created image sequences by the Crop Dimensions will have a generic name “Cropped” 

which is extended by a number at the end of the sequence name like “Cropped_2”. 

These new sequences can then be exported via the Export function in the File menu. 

 

 

8 Hardware Control Panels 

8.1.1 Primary Control Panel 

There are a handful of controls that are always needed and provided with the LA Dashboard.  The 

defaults provided are for Setting Storage Control, Z-Axis Focal Control, Objective Changer, XY 

Stage Control, 2-D Navigation Control, Image Marker,  

Camera, Camera Properties, Light Selector, Display Options, Filter, and Streaming Controls. 

8.1.2 Secondary Control Panel 

On the right side of the main viewing area is a secondary hardware control. This control is 

composed of a pair of combo-text boxes with roll bars and a pair of buttons. From this control 

maximum and minimum color correction can be established as well as an auto contrast 

correction.   

8.1.3 Status Bar Control Panel 

At the bottom of the viewing area is a status bar indicating current state of hardware and protocol 

execution. 

 

8.1.4 Primary Control Enhancement Panels (Collapsible Panels) 

As mentioned earlier the Live Acquisition solution is dynamic and designed to be updated and 

expanded as the needs of your experiments change or is adapted.  Various default views and 

experiments dynamically load the necessary controls into the dashboard and unnecessary controls 

are removed.   

 

8.1.4.1 Lighting and Filter Control Panel 

At the bottom of the viewing are above the status bar is a dock able control panel showing the 

current filter and lighting settings.  Opening and closing this window adjusts the overall display 

of the viewing pane. 
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8.1.4.2 FRET Secondary Control Panel 

In FRET configurations a second secondary control window appears directly to the right of the 

primary control window so that the main viewing window is sandwiched between the two 

secondary control windows. 

 

8.1.5 Execution Control Panel 

Directly beneath the primary control window is the execution window.  It contains buttons to 

control Experiment, Live and Still modes of operation.  These three provide out of the box control 

for hardware so that you can quickly examine a sample or series of samples in a rapid manner and 

quickly determine if it is worthwhile to continue running experiments on the samples.  One of the 

advantages of the Live Acquisition solution is its ability to be used in screening applications and 

this is built directly into the core concept of the user interface.  As it is constantly being 

manipulated here can also be found the exposure time control. 

 

8.2 Hardware Positioning Controls 

8.2.1 Z Axis and Objective Focal Controls 

The Z Axis and Focal Controls directly manipulate the hardware as you change the settings on the 

graphical display.  This corresponds to an equivalent movement of the focus axis.  Every time this 

is done a new picture is made.   

 

The Objective Focal Control allows you to change different magnification ratios as well as 

different focal forms (air, oil, etc) based upon what is available in the configured hardware from 

the hardware configuration.  The control is seamlessly updated with the right click context menus 

to select the focal setting desired.  With a left click the objective is lifted up and down into focus 

position.   

 

Fine tune focusing is accomplished either with the text box, roll bars, or directly with the mouse 

and Space Navigator. 
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Figure 48: Z and Object Changer Control 

 

Finding the Right Focus is the one most important feature of any microscope. 

Live Acquisition allows multiple ways of configuring and doing this as each experiment and each 

user has different needs. 

 

Focusing can then be achieved by: 

 use of the Mouse Scroll Wheel (Manual Focus) 

 the keyboard <CTRL> key combined with the Mouse (Autofocus) 

 directly entering absolute values in the Focus Control GUI (Manual Focus) 

 using the Mouse to drag the slider of the Focus Control GUI (Manual Focus) 

 Right Mouse Click in the Viewing Panel to open a context menu (Autofocus) 

 Returning to Z Home or a ZMarker Position 
 

8.2.1.1 Mouse Scroll Wheel Manual Focus 

To change the focus one must roll the mouse wheel up increases the absolute position of the Z 

drive thereby increasing the focus level. One can also roll the mouse wheel down lower the Z 

drive thereby decreasing the focus level using the last used step width. This facilitates fine-tuning 

when approaching the final position. 

When one right-clicks onto the Display area, a context menu opens that contains the step sizes for 

the focus controls (Mouse wheel and Page up/Page Down keys). 

8.2.1.2 Z Focus Text Box Manual Focus 

A first order focus can be achieved by typing in an approximate focal level in the text box. 

8.2.1.3 Fine Motion Z Focus Slider Manual Focus 

One can achieve sub micrometer focus control without the need to adjust default focal step sizes 

by using the Z Focus slider.  This slider however is limited in focal ranges of +/- 250 

micrometers. 
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8.2.1.4 Autofocus 

The Autofocus action will both set a new focal step size and perform an autofocus with the 

currently configured autofocus algorithm. 

Invoking auto focusing is done by using the mouse right button in the viewing window and 

selecting the autofocus action item. 

 

 
Figure 49: Autofocus and Auto Contrast 

 

This can be combined with selecting new focus steps as well as setting an autofocus region.  

Setting an autofocus region is achieved by selecting this option from the context menu and then 

using the mouse left button to rubber band highlight a ROI in the viewing panel.  

8.2.1.5 Z Marker Manual Focus 

The Z Marker is similar to the Z Home but it allows multiple Z Positions to be marked and then 

to select them from a pop up list.  Selecting one of the list entries will return the focus to this 

position. 

 

8.2.1.6 Setting the Focus Steps 

To configure the focus Steps for the objectives in a system the user has to open the Step 

configuration dialog (Figure 50) from the menu bar Config > iMIC > Focus Control 

Configuration. 

 

 

 
Figure 50: Dialog for configuring the step sizes for the focus controls. 

. 
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8.2.2 XY Axis Stage Controls 

The XY Axis stage controls directly manipulate the hardware as you change the settings on the 

graphical display.  Every time this is done a new picture is made.  

 

Finding an AOI is the second most important feature of any microscope.  Live Acquisition allows 

multiple ways of configuring and doing this as each experiment and each user has different needs. 

 

The following feature allows display of 2x2 or 3x3 images simultaneously thereby allowing 

Snapshot & Live mode to provide a rapid manual screening. 

• Panorama Viewing 

• Panoramic Move 

 

The following experiments aid finding AOIs 

• Tile and Stitch    

 

The different methods that LA has of navigating in XY and finding and marking AOIs are: 

• 2D Navigator Control 

• the keyboard <SHIFT> key combined with the Mouse to re-center 

• the keyboard <X> key combined with the Mouse to act as virtual joystick 

• directly entering absolute/relative values in the Stage Control 

• using the Image Markers to return to a previous marked AOI 

• Space Navigator Joystick &/or Mouse based Panoramic Move 

• Returning to XY Home Position 

  

8.2.2.1 Panorama Viewing 

From the Live Acquisition menu, selecting Acquisition > Panorama Size one is able to select 

between a multi-image viewing modes whereby 2x2 or 3x3 images can be displayed 

simultaneously on the Live Acquisition viewing panel. 

 

In the execution panel is a checkbox which turns and turn off the panoramic viewing mode.  

When this mode is activated it allows a peripheral view of what lies next to the region where the 

stage is currently centered. 

 

When the 2x2 mode is active the hardware moves in the following pattern displaying the 

neighboring sample areas and then returning back to the original stage position.  This all happens 

with a single click on the ‘Snapshot’ button.  What are displayed in the Viewing Panel are a 2x2 

Tile and Stitch Image of the surrounding areas. 

 

 

When the 3x3 mode is active the hardware moves in the following pattern displaying the 

neighboring sample areas and then returning back to the original stage position. This all happens 

with a single click on the ‘Snapshot ‘button.  This all happens with a single click on the 

‘Snapshot’ button.  What are displayed in the Viewing Panel are a 3x3 Tile and Stitch Image of 

the surrounding areas. 
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8.2.2.2 Panorama Movement (Full Screen and Half Screen) 

Just as Panoramic Viewing aids in seeing what lies around the centre point of the stage the 

panoramic movement allows rapid movement to both quickly manually scan a sample as well as 

to prevent the sample from being overexposed by light.  The two features are capable of being 

used together. 

 

   
Figure 51: Panoramic Movement Borders 

 

The fastest and easiest way to activate the panoramic motion is to use the Space Navigator 

Joystick.  Moving the joystick left, right, up or down will trigger the full screen panoramic 

movement.  This is indicated by the double arrow appearing on the border of the viewing panel as 

the stage moves a full screen in the desired direction. 

 

It is also possible to use the mouse and keyboard in panoramic mode.  Holding the <SHIFT> key 

down and moving the mouse cursor to one of the four edges of the Viewing Panel until the border 

changes.  If the border is a single arrow then a half frame motion will be activated with a left 

mouse click.  If the border is a double arrow then a full frame motion will be activated with a left 

mouse click. 

8.2.2.3 Re-centering the XY Stage 

A hidden control is also available to move the XY stage.  By pressing and holding the <SHIFT> 

key on the keyboard with the mouse in the viewing window, the XY stage has a floating region 

displayed in the GUI.  When the mouse left button is pushed the stage will re-center on this 

position. 

 

As the XY position is changed the Global and Zoom Viewers and the XY Axis Control are 

updated accordingly. 

8.2.2.4 Joystick 

The LA Software supports almost any HID (Human Interface Device) compatible USB Joystick 

for controlling the xy-stage. Nowadays all available USB Joysticks are HID compliant. 

Alternatively the Space Navigator Device can be used for XY movements. 

Both, the HID USB Joysticks and the Space Navigator, can be easily configured between normal 

joystick mode and panoramic movement mode by a checkbox in the menu: Navigation > Joystick 

Mode. 

A HID compatible joystick can be attached and used with LA without restarting LA. After a 

Joystick has been connected to the computer and Windows finished the installation of the 

joystick, the Joystick can be activated in LA by going to the menu Config > Start HID Joystick. 

8.2.2.5 XY Stage Text Box Manual Motion 

It is possible to enter the absolute/relative values into the Stage Control by using the edit fileds. A 

movement is carried out when the “return” or “enter” key on the keyboard is pressed. 
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8.2.2.6 XYZ Position Markers (User defined) 

A Position Marker is similar to the XY Home but it allows multiple positions to be marked and 

then to select them from a drop down list.  Selecting one of the list entries will return the focus to 

this position. 

 

. 

Figure 52: Position Marker 

 

The Position Marker is similar in to how the Z Reference works.  But it not only stores a position 

but all the parameters necessary to exactly recreate the image including camera and light settings. 

 

Position Markers can be set by depressing the ‘+’ key either thru the numlock or the normal 

keyboard.  This allows markers to be set while performing manual screening and then to easily 

return to the interesting positions. 

Position markers can also be added and removed by using the buttons right to the Position Marker 

list. The ‘+’ button will add a user defined Position Marker to the list. 

 

 
Figure 53: Position Marker Panel buttons 

 

The edit icon, depicted by the “pen” icon, will open a dialog for managing the position markers. 

Available functions for managing position the markers and their properties include renaming, 

deleting and changing xyz-parameters (Figure 54).  

Multiple markers can be selected by either holding down the “shift” or “Ctrl” modifier key. This 

allows deleting multiple markers at once. The behavior is the same as in the Windows Explorer. 

 

 
Figure 54: Dialog for editing xyz-markers and their properties. 
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8.2.2.7 XYZ Position Marker (Pre-defined) 

The Position markers can be switched from User defined to pre-defined if a Well plate is 

configured in the navigator. In this mode the User is presented with a list of the center positions 

of the wells in the Well plate. 

 

 
Figure 55: Pre-defined Position Marker list 

 

In contrast to the user defined Position Markers the pre-defined markers do not have a z-position 

by default. They only have the x and y position of the well center. The current z-position is used 

if the Well is changed. Depending on magnification of the objective and the flatness of the well 

plate it might be necessary to adjust the focal position after the stage has moved to a new well. 

The user can not add markers to this list, they are given by the dimensions of the well plate. 

To adjust the z-positions the User can run the “Marker Focus Map” protocol. This protocol will 

try to find the best focus for each position, starting at the current z-position. 
 

8.2.3 Navigator Controls 

The navigator control is designed similar to a ‘Heads Up Display’ in a cockpit.  It allows rapid 

navigation of a sample in a manner in a Random Walk format as well as providing a scratchpad 

of highlighting regions of interest (ROI) and points of interest (POI).  The navigator is divided 

into two regions which can be hidden and resumed separately depending on your current needs. 

 

 Global View 

 Zoom View 

 



                         Live Acquisition Software Documentation v2.2.0 

66 

 

 
 

Figure 56 : XY and Navigator Control 

 

There is a check box here to either allow or disallow hardware movement as you are selecting 

regions and points.  When it is selected every new point will be moved and an immediate image 

will be made.  This is very useful for rapid scanning. Otherwise it can be disabled to allow a more 

complicated pattern of regions and points to be developed to be later used in a scanning protocol. 

 

Note that it is possible to select points in both the global view and the zoom viewer.  But only 

points and regions will be displayed in the zoom view. Selecting points is simply a matter of left 

clicking in the control with the mouse.  Dragging the mouse cursor over a region in the Grid 

View with the left button depressed will select a ROI. Single clicking into any grid position with 

the left mouse button will select a POI. Depressing the right mouse button on any selected point 

removes it from the list to be tiled. The yellow cursor highlights the current hardware position of 

the stage.   

 

 
Figure 57: ROI Enabled Navigator 

 

As the XY position is changed the Global and Zoom Viewers and the XY Axis Control are 

updated accordingly. 
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There is a configuration tool available under Navigator Menu that allows setup of the stage 

sample holder.  It allows a rapid selection of slide, Petri, or well plate.  As well as allowing 

calibration of the GUI and hardware so that the GUI remains in sync with actual hardware even 

after changing the sample dishes.  In some configurations of samples it is necessary to reverse the 

viewing angle of the sample (top down vs. bottom up) or to reverse the motion of the X, Y axis 

for better data collection.  This is also accomplished with this configuration tool.  Please refer to 

the setup and installation manual for details. 

8.2.3.1 Global View 

The global view is at the top of the navigator window.  It provides a virtual view of the entire 

stage, attached slides, attached Petri dish, or attached wells.  With a left click in the navigator, the 

stage moves to center the point chosen under the objective.  It is also possible to drag and drop a 

rectangle with the left mouse button to select a larger area.  Any POIs and ROIs which have been 

selected are shown in this window in a scale corresponding to the stage size.  The global view can 

be hidden / resumed using the arrow in the top right corner of the control.  The current zoom view 

and location of the image currently under the objective is shown in the global view as a small set 

of corners marking the location of the smaller rectangle of the Zoom Viewer. 

 

8.2.3.2 Zoom View 

The zoom view is found immediately below the global view.  It can be hidden / resumed using 

the arrow in the middle right corner of the control.  This view shows the same view that the 

camera has as a background image and allows the user to select ROIs and POIs by using the right 

mouse button.  Note that the zoom and what is in the camera CCD delivers is always in sync.  A 

note here is that the pixels displayed in the zoom view directly correspond to the CCD images of 

the camera.  Selected regions can also be erased by a second left click on the same location. A 

global erase button is also provided that erases all regions in both global and zoom windows. To 

select a POI simply move to the location on the grid and click. To select a ROI move to a grid, 

point, click, and drag and drop to the desired location of the opposing corner. A highlighted 

region will be drawn.  A corresponding ROI / POI will be displayed in the Global View. The 

zoom view can also be used in a scrolling mode to move the stage.  There are four arrows at the 

edges of the Zoom Viewer for this.  The Global view is shifted as is the stage.  And as the name 

states the Zoom view can be zoomed with the use of the mouse roll bar. 

 

8.3 Primary Hardware Configuration Controls 

Certain other hardware controls are used almost as often as the positioning controls and they are 

always available in the Primary Hardware Control Panel.  Others are configured less often and are 

hidden from the main hardware control and appear as a docking window to the right of the 

primary control panel.  The following is a short description of the primary controls for 

configuration. 

8.3.1 Light Source 

Changing the Wavelength, Intensity (optional) and Bandwidth (optional) of the Polychrome V 

from the Live Acquisition software is done in the Light Source control panel. 
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Figure 58: Light source control panel for the Polychrome V 

 

 

The graphically control can be moved by a right mouse click and a drag.  There are three yellow 

circles in the graphical spectrum slider.   

 

 Clicking and dragging in a vertical fashion on the topmost one will change the intensity. 

 Clicking and dragging in a horizontal manner on the middle one will change the 

wavelength. 

 Clicking and dragging in a horizontal fashion on the lowermost one will change the 

bandwidth. 

 

Intensity, wavelength, and bandwidth can also be edited directly with the roll bar. 

8.3.2 FRET Mode 

If the FRET module is configured then an additional control appears.  From here there are two 

options. When using the FRET filters 2, 3, and 4 it is possible to mirror the images. It is also 

possible to overlay the two images for direct comparison. 

 

8.4 Move and Shoot Mode 

When first started, the default mode of operation for the Live Acquisition solution is a ‘Move and 

Shoot’ mode for manual scanning.  In this mode there is little to nothing that must be configured 

and one can start investigating samples within minutes of beginning to use the Live Acquisition 

solution. 

 

In ‘Move and Shoot’ mode samples can be recorded in either a still snapshot mode or in a live 

mode. 

 

The default mode of the ‘Move and Shoot’ is a non-persistent picture. This means that even 

though a picture is taken at the end position of every move it is not immediately saved to the hard 

drive or sent to the Offline Analysis application. The current image can be sent to the Offline 

Analysis application or saved to the hard disk for later analysis by clicking on the ‘Save’ Button. 
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9 LA Protocol Editor 
 

The LA Protocol Editor allows the user to create and manage complex workflows with ease. The 

user can build workflows with the pre-defined Protocols from the Live Acquisition and simple 

commands, like ‘Snapshot’ and ‘Trigger’. The items in the workflow can be easily rearranged via 

drag and drop or with standard key shortcuts. The workflow is presented as a hierarchical tree 

view (Figure 60). Workflows generated with the Protocol Editor are optimized for the best timing 

before they are sent to the Imaging control unit where they are executed in real-time. 

9.1 Exploring the interface 

 

The Protocol Editor is started by selecting it from the Experiment button in Live Acquisition. The 

Protocol Editor is the first item at the bottom of the list, see Starting the Protocol Editor. 

 

  
 

Figure 59: Starting the Protocol Editor from the Experiment list. 

Selecting the Protocol Editor item will then open an additional window that floats above the other 

Live Acquisition interface elements. The first look at this window will present the interface 

elements of the Protocol Editor seen in Figure 60. 
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Figure 60: Protocol Editor Window 

 

9.1.1 The menu bar 

 

The menu bar consists of three items, File, Edit and Add Protocol. 

 

 
 

 

The File menu contains options to manage protocols, to load save, and create them. In the File 

menu the following options are available:  

 

• New : Clears the current Protocol without saving! 

• Load: Opens a dialog where the user can select a protocol to be loaded 

• Save as…: Saves the current protocol to a specified location; a name can be given to the file 

• Recent files: a list of recently used protocols, allows fast access to frequently used protocol 

files 

 

Workflow area

Protocol

information

Simple

commands

Protocol items 

in tree view

Workflow canvas

Protocol

information

additional

commands

Protocol items 

in tree view

Menu and 

tool bar



                         Live Acquisition Software Documentation v2.2.0 

71 

 

 
 

Functions for editing the protocols can be found in the Edit menu. The options in the Edit menu 

are: 

 

• Cut: copies the current selected protocol item to the clipboard and deletes it from the protocol 

• Copy: copies the current selected protocol item to the clipboard 

• Paste: pastes the protocol item from the clipboard to a protocol 

• Delete: deletes the currently selected item in a protocol 

 
 

In the Add Protocol menu item all available protocol items for the configured hardware are listed.  

Selecting one of these items in the menu will add it to the protocol tree in the workflow canvas.  

 

 
 

9.1.2 The Tool Bar 
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The tool bar contains buttons with icons that allow fast access to functions of the Protocol Editor, 

without going to the menus in the menu bar. 

 

 
 

9.1.3 Additional Protocols panel 

On the right side of the Protocol Editor Window the Additional Protocols are kept. These are so 

called Simple Commands, which allow a finer control in building a protocol if needed. 

Depending on the hardware configuration some items are not accessible to all users. A list with a 

description of the Simple Commands functions can be found in chapter 16. 

The Simple Commands can be dragged with the mouse to the Protocol Canvas and thereby added 

to the Protocol. Note: Dragging of items to an empty Protocol Canvas is not allowed.  

 

 
 

9.1.4 File Options panel 

The File Options panel holds controls, which allow influencing the way how the acquired image 

data is stored in the files and if channels are stored in separate or in one file. 

 

 
 

The options Append to previous file is only active if two or more items that acquire image data 

are following each other. These could be two Snapshots or two Time Lapse items. It is also 

possible that a Snapshot follows a Time Lapse item, but in this case both items need to have the 

same “dimensions”! A dimension is not only x,y and z but also the number of channels. In other 

words this means that a Snapshot, which is a single/one channel acquisition, cannot be appended 

to Time Lapse item with a two channel acquisition! 

 

The second option in the File Options is the selection to what dimension the acquired image(s) 

will be added. Images can be appended in time – t -, as another channel – c – or in the z-direction 

– z- to a file. 
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9.1.5 Protocol Information 
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9.2 Protocols: Getting started 

The first Protocol that will be built in this tutorial consists of two Time Lapse acquisitions and a 

Trigger item. The Time lapse items will be configured to acquire a series of 100 images at one 

wavelength. Between those two Time Lapse items the Trigger item is placed to trigger an external 

device like an electrical stimulator. 

 

Required hardware: 

• TILL Photonics imaging system  

• Light source (Polychrome V or Oligochrome)  

• Imaging Control Unit  

• Camera 

Protocol items described in this tutorial: 

• Time Lapse 

• Trigger 

Recommended chapters: 

4.1, 4.1.1, 4.1. 

 

The first step is to add a protocol item to the workflow canvas in the Protocol Editor. This is done 

by clicking the Add Protocol menu in the Protocol Editor. This menu consists of a list with all 

available protocol items appropriate for the installed hardware. 

To add the first Time Lapse item to the sample protocol select the Time Lapse item from the list. 

 

 
 

This action will add a Time Lapse item to the Workflow canvas. 

 

 
 

To edit the properties of this Time Lapse experiment, it needs to be activated by selecting it with a 

mouse-click. When the Time Lapse experiment in the Protocol Editor is selected, the panel with 

its settings is opened on the left side of the LA Acquisition window. 

 



                         Live Acquisition Software Documentation v2.2.0 

75 

 

 
  

In this panel the properties of the Time Lapse experiment can be edited like in the pre-defined 

Experiments. The Time Lapse properties reflect the current setting from the Live and Snapshot 

settings; this includes the exposure time and light source settings like the wavelength. 

This shows the tight integration of the LA Protocol Editor with Live Acquisition. Usually these 

settings where used before by the User in Live or Snapshot mode as he was searching for a good 

spot in the specimen to make an experiment. 

 

However, if the User needs to make changes to properties, these changes  are made immediately, 

there is no need to explicitly save them when switching between multiple protocol items or 

adding new ones to the workflow canvas. 

 

The next step is to add the Trigger item to the protocol by selecting it from the Add Item > 

Trigger. 

 

 
 

Selecting the Trigger item will show its properties in the experiment panel on the left side of the 

Live acquisition window labeled as DO Control. 

Setting the property “Pulse” in the Trigger items will generate a Pulse of a given duration, here 

0,1ms. 
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To add the second Time Lapse, two possible routes can be taken. One route is to add another Time 

Lapse item from the Add Item menu like in the first case.  

The second route is to copy and paste the first Time Lapse item. To copy the Time Lapse item, it 

first needs to be selected by clicking on it. Then it can be copied either by using the “Copy”-icon 

in the tool bar of the Protocol Editor window or by using the Shortcut keystroke “ctrl-c”. Pasting 

is done by either the “Paste”-Icon form the tool bar or by the “ctrl-v” key combination. 

 

.  

 

To add the Time Lapse item below the Trigger item we first have to select the Trigger item, or in 

general the item after which the new one should be added. This step is independent of whether the 

item is added via copy and paste or via the “Add Item” menu. 

Adding/Pasting the Time Lapse into the protocol is done either by the paste icon or by the 

shortcut keystroke “ctrl-v”. 

 

 
 

For later evaluation the images of both Time Lapse sequences should be combined in one file. To 

achieve this, the Append to previous file option in File Options has to be checked. Otherwise the 

two Time Lapse items will create a file for each own image sequence. 

To save the protocol go to the File > Save as… . This will open a dialog asking you to give the 

protocol a file name under that you can reload it for later re-use. 

 

To save the data press the Acquire button  (the one with the red circle). 

To run the protocol just built; press the Play  button (the one with the green triangle) in LA 

Acquisition. Custom protocols built with the Protocol Editor are controlled in the same way that 

the pre-defined Protocols are. 
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While the experiment is running, the Acquire button changes to a Pause button. Clicking the 

Pause button will temporarily stop the protocol. To resume the protocol execution, press the 

button again. 

 

 
 

To terminate the protocol execution early, press the Stop button. Pressing Stop does not discard 

any data already recorded. 

 

Try this: 

 

Feel free to try out the interface.  
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• Rearrange the Protocol by dragging and dropping items. 

• Add a second Trigger item at the beginning of the Protocol 

• Delete items by pressing the “Del” key 

• Create a new Protocol by pressing the “New” icon; add all three items first before editing 

their properties 

 

9.3 Protocols: Nesting items in a loop 

 

The protocol that will be created in this chapter shows the use of the Loop item and another 

Simple Command, the Snapshot. The nesting of items will be shown, by using the Loop and 

Snapshot items to create a time lapse experiment from Simple commands instead of using the 

pre-defined Time Lapse item. 

The goal is to build a time lapse experiment with 100 repeats and to take two snapshots in this 

loop. One Snapshot should take a fluorescent image and the other snapshot a transmission image. 

Another goal is to introduce the usage of the File Options in the protocol editor, here the Append 

to previous file. 

 

Required hardware: 

• TILL Photonics imaging system  

• Light source (Polychrome V or Oligochrome)  

• Imaging Control Unit  

• Camera 

Protocol Editor Items described in this tutorial: 

• Loop 

• Snapshot 

• Append to previous file 

Recommended chapters: 

• 4.1, 4.1.1, 4.1. 

 

Open the Protocol Editor and if another is still there, save it and then press and then press the New 

icon in the tool bar or select by going to the menu File > New in the Protocol Editor window. 

 

 
 

The next step is to add a Loop item to the protocol. This is done by the going to the menu Add 

Protocol > Loop.  
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Select the Loop item and go to the property panel and change the Loop Count to 100. 

 

 
 

A Snapshot item is added by Add Protocol > Snapshot. This Snapshot item should be configured 

to take a fluorescent image. Therefore select the first Snapshot item in the Workflow canvas and 

change the Light Source in the Snapshot panel to Polychrome V or Oligochrome depending on 

your setup. If the User was using the Polychrome light source before in Live- or Snapshot-mode, 

usually no change to the parameters in necessary. 

 

 
 

Now the second Snapshot item should be added and configured to be a transmission. The change 

is needed here as this item also defaults to the Live- and Snapshot-mode settings. Changing to 

transmission is done by setting the Light Source to None. It might be necessary to adjust the 

exposure setting.  

 

 
 

The protocol now has all three items sitting in line to each other. If the protocol would now be 

run, only two images would be taken as the two Snapshots are not nested in the Loop item. The 

dotted line to the left of the protocol items shows that all three items are on the same level. 

 

 
 

To get the two Snapshots executed within the Loop item, they have to be dragged onto the Loop 

item one after another. If a protocol items is dragged over another protocol item, the mouse cursor 

will change and display an additional plus right below the arrow of the mouse pointer. 
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If the mouse button is now released, the dragged Snapshot item will become a “child” of the Loop 

item. 

 

 
 

Hint: If a protocol item has child/nested items, it will display a “plus” or “minus” in a 

small box left to it. By clicking onto this “plus” or “minus” the child/nested items will be 

shown or hidden. This behavior is consistent with that from the Windows Explorer when 

navigating the Folders. 

 

The next step is to move the other Snapshot to the Loop item, too. This is done by dragging it to 

over the Loop item as previously described. 

 

 
 

 

If the protocol is now run, we will get two files, one containing the images with the fluorescent 

excitation and the other containing the transmission images only. This is independent of the 

streaming option currently in use, Offline Analysis application, TIFF or ImageJ. 

If the Offline Analysis or ImageJ is used, two windows will be opened, each containing a 

complete sequence of 100 images, one the fluorescent images and the other the transmission 

images. 

 

If the User wants to combine both image types (fluorescent and transmission) in one file, the 

second Snapshot has to be selected in the protocol. This will enable the File Options on the right 

side in the Protocol Editor window. 

 

 
 

In this example the fluorescent image should go into channel 1 and the transmission image into 

channel 2 of the same file. To do this, the option Append to previous file needs to be checked and 

from the drop down list the “c” – for channel – has to be selected.  
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Hint: The other options in this drop down list are “t” – append images in time – and “z” – 

for appending images in z-direction. See chapter 9.1.4 

Now the protocol will create one file containing both sequences. If the Offline Analysis 

application is used switching between the two channels can be done easily. For further details 

please refer to the Offline Analysis chapter 6. 

If the image data of the protocol is streamed to TIFF files or the ImageJ TIFF streamer, the 

images will be “multiplexed” in the TIFF-file. This means they are stored in an alternating 

sequence: Channel1, Channel2, Channel1,…. 

 

 

Try this: 

Feel free to try out the interface. 

 

• Re-arrange the two Snapshots, to first take the transmission and then the fluorescent image 

• Test what happens if “z” or “t” is selected in the File options 

• Add a snapshot with transmission before and after the loop 

• Add snapshot fluorescence 

9.4 Multi-channel Z-Stack 

 

The goal of this chapter is to demonstrate how to build a z-stack with two channels over time. 

This is sometimes referred as a 4D experiments. 

This tutorial also shows how to replace the standard acquisition, a snapshot, of a protocol item, 

here the z-stack. 

 

Required hardware: 

• iMIC series microscope 

• Light source (Polychrome V or Oligochrome) 

• Camera 

Protocol items described in this chapter: 

• Loop 

• Z-Stack 

• Time Lapse 

• Nesting of items 

Recommended chapters: 

• 4.1, 4.1.1, 4.1. 

The first item we add to the empty working canvas is the Loop item; Add Protocol > Loop 
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Select the Loop item and change the counter of the loop to 50. 

 

 
 

Now we add a Z-Stack item to the protocol; Add Protocol > Z Stack 

 

 
 

To edit the Z-Stack properties, select the Z-Stack item in the Protocol Editor and change the 

properties to appropriate values. For this example a Z-Stack with 15 frames, a Z-step size of 5 µm 

is chosen and the Direction of acquiring is upwards from its current position (select the up 

pointing triangle). 

 

 
 

To repeat the Z-Stack 50 times, as we have it specified in the Loop item, it has to become a child 

of the Loop item. This is done by dragging the Z-Stack item onto the Loop item. The mouse 

cursor will then change a seen in the following picture. 
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If the protocol would be run now, fifty Z-Stacks each containing 15 frames or z-planes would be 

acquired with the current camera and light source settings. 

The standard behavior of items like the Z-Stack or (Relative) Tile and Marker Scan is to use the 

current settings from the LA Acquisition, which were used in Live or Snapshot mode. 

 

Important! 

The goal of this tutorial is to acquire a two channel z-stack over time, so the standard behavior of 

the z-stack, a single Snapshot, needs to be replaced.  

The standard Snapshot feature of the Z-Stack will be replaced by adding a Time Lapse item. 

However, the Time Lapse item has to added to the protocol in a first step; Add Protocol > Time 

Lapse 

 

 
 

The next step is to activate the Time Lapse item in the Protocol Editor and set its properties to be 

a two channel experiment with for example a 440nm excitation on channel 1 and 490nm on 

channel 2. 

The Cycle count property in the Time Lapse item is left at 1 (one) as only one pair of images 

should be taken in one plane of the z-stack before going to the next plane. The Time Lapse now 

basically behaves like two Snapshots. The Advantage of using the Time Lapse item instead of 

two Single Snapshots is that the User doesn’t have to bother about the File Options settings. Both 

channels will be stored in one file. 
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Next up is the placement of the Time Lapse item as a child of the Z-Stack by dragging it onto the 

Z-Stack item. 

 

 
 

This was the final step to build a two channel Z-Stack that is acquired over time. Now the 

protocol can be started by pressing the Play button in LA Acquisition. To save the acquired data, 

the user has to press the record button. If the user wants to test the protocol before acquiring data 

the play button can be use. 

 

Try this: 
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• Replace the Time Lapse item with two Single Snapshots 

• Replace the Time Lapse with a Multi channel item and acquire three channels 

• Replace the Time Lapse with a Relative Tile item and acquire a 3x3 tiles per plane 

 

9.5 Advanced Protocols: Multi position (Wellplate) scan 

 

The goal of this section is to record an image at the center of certain wells of a well plate, with 

two wavelength. Additionally the acquisition for each well is repeated 10 times. 

This will demonstrate how to replace the standard snapshot functionality of the Marker Scan 

protocol item with a two wavelength acquisition. 

 

Required hardware: 

• iMIC series microscope with a Prior Stage 

• Light source (Polychrome V or Oligochrome) 

• Camera  

Protocol items described in this tutorial: 

• Marker Scan 

• Loop 

• Time Lapse 

Recommended chapters: 

• 4.1, 4.1.1, 4.1. 

 

If necessary save any previous protocol in the Protocol Editor and then clear it by using the New 

command either from the File-menu, File > New, or by using the New icon in the Toolbar.  

 

The first item to add to the Protocol is the Loop (Add Item > Loop) and we set its Loop count 

property to 10. 

 

 
 

Now the Marker Scan item should be added to the protocol canvas (Add Item > Marker Scan) 

and then dragged onto the Loop item to make it a child of the Loop. 

 

 
 

The next step is to edit the list of wells that should be scanned by the Marker Scan item. 

Therefore the Marker Scan item needs to be selected. Make sure that the Predefined option is 

selected on top of the panel.  If this option is selected a list of all available well center positions 

(A1, A2, …C11, C12…) is shown in the upper list view of the panel. 

In this example only the row A should be selected, in case of a 96 well plate this would be A1 to 

A12. To do this in the Marker Scan Protocol properties the first item, A1 needs to be selected. 
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Now hold down the Shift-key and click on A12 in the list. Now the Shift-key can be released. To 

add the selected wells from the Available Position Markers list to the Position Marker List the 

Plus-icon  needs to be clicked. 

 

 
 

Now that the desired wells are added to the list of positions that will be scanned in the protocol, 

the standard Snapshot functionality of the Marker Scan item will be replaced with a two 

wavelength Time Lapse item, that has only one repetition . To achieve this, a Time Lapse item 

needs to be added (Add Item > Time Lapse) and dragged onto the Marker Scan item to make it a 

child of it. 

 

 
 

Now the properties of the Time Lapse item needs to be set. The screen shot shows an example 

configuration with two excitations wavelength (440 and 490 nm). For this tutorial the Cycle count 

should be left at the value of one. 

 

 
 

Leaving the Cycle count  value at one, will take two images at two wavelengths (440/490nm).  

The protocol then moves on to the next well in the Position Marker List. 

 

If this Protocol is now run, a total of 12 sequences each with two channels are generated. The two 

images of each Time Lapse will be appended to the previous one. 
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Try this: 

- Take a Time Lapse of 100 frames at each well, therefore remove the Loop item. Hint: 

move the child items of the Loop out of it before removing the Loop item. 

 

10 Stage calibration for sample holders 
 

This chapter describes how stage calibrations for a variety of sample holders, like slides, dishes 

and well plates can be create and saved easily with the Calibration Wizard. The described process 

is the same for all supported stages available on the iMIC and uiMIC, making it easy and 

consistent across all devices. 

 

Required hardware: 

iMIC series microscope with any of the available stages or a uiMIC microscope 

Transmission light source or any epi light source  

A CCD Camera  

Recommended chapters: 

3.2.1, 3.2.2, 3.2.4 

 

To start a calibration, open the Calibration Wizard from Navigation > Navigator Calibration 

Wizard 

 

 
Figure 61: Open the Navigator Calibration Wizard 

 

The Calibration Wizard opens and will ask to select the basic sample holder type that will be 

calibrated. Choices are Slide for rectangular sample holders, Petri dish for round sample holder 

and Wellplate for sample holder with multiple wells. 
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Figure 62: Selecting the basic sample holder type for a calibration process 

 

After selecting one sample holder type, a warning will be shown before starting the calibration 

process (Figure 63). The area of the stage should be cleared, as during the calibration process the 

stage might travel its full range. During the calibration the user is able to use the whole, 

unrestricted travel range of the stage! 

 

 
Figure 63: Warning before starting a calibration 

 

If Slide of Petri Dish was chosen as a sample holder type the calibration starts by pressing the 

“Next” button. The user is then asked to move to different calibration points. 

Moving the stage can be done by using all navigation features available in the Live Acquisition 

software.  

 

- Move and Shoot  

- Software Joystick 

- Clicking into Global- and Grid view 

- USB-Joystick 

- Direct input of  x- and y-coordinates using the Stage panel 

- If Wellplate was the selected sample holder type, an additional step is needed before the 

calibrations start. In this step the user selects the shape of the wells (Figure 64). Depending 

on the selected well shape the appropriate calibration process is started by pressing 

“Next”. 

 

 

 
Figure 64: Selecting the appropriate well shape 
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Navigate to the calibration points by using the above mentioned navigation tools in LA 

Acquisition. Press the “Next” button when the calibration point is under the red cross-hair (Figure 

65), which is displayed in the LA image view area during the calibration process. 

 

 
Figure 65: LA main screen with Navigator calibration wizard open 

 

After setting all required calibration points the Calibration Wizard asks for a name under which 

the calibration will be saved. 

 

 
Figure 66: Saving a navigator calibration 

 

The saved calibrations can be selected from the Navigation > Calibrations menu. Thre recently 

used five calibrations are directly listed in the Navigation menu. 

 



                         Live Acquisition Software Documentation v2.2.0 

90 

 

 
Figure 67: Recall a saved navigator calibration 

 
 

11 Objective Alignment (xyz Translation) 
 

This chapter describes how the parfocality of the objectives can be set in the Live Acquisition 

software. This chapter describes the steps necessary to calibrate the objectives in the microscope 

system. As a result all objectives will “see” the center same area of the sample. 

The objective alignment feature in the Live Acquisition software will correct the x, y and z-

translation of all installed objectives in the system. 

Starting an objective alignment is done from the Objective Alignment dialog. This dialog is 

opened from the menu Config > iMIC and Imaging Control Unit > Objectives Alignment. 

 

 
Figure 68: Objective Alignment dialog 

 

From this dialog the Alignment Wizard can be started which guides the user through the 

calibration process step by step. 

 

Hint: If there are objectives which need an immersion medium like Oil or Water, this has to be 

added onto the objectives in advance (before starting the Alignment Wizard)! 

 

The Alignment can be enabled or disabled globally or for each objective individually in the list. 

Manual modification of the alignment parameters is also possible in the list but is usually not 

necessary. 

When starting the alignment Wizard a red cross-hair is shown as overlay over the camera image. 

To adjust the objectives alignment you should chose a relive simple structure that is easy to find 

and has a high contrast. 

We recommend using a micrometer calibration slide and to use one of the corners of a number on 

the scale as structure. 
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For the calibration you have to move the same structure under the cross-hair for each objective. 

You can use all navigation features available in the Live Acquisition software like, the USB or 

Software Joystick, the Click-to-Center function or the cursor keys on the keyboard. 

Once all objectives have been aligned the Wizard will return to the dialog where it was started 

from. 

 

12 FRAP calibration 
 The FRAP calibration in LA 2.0 and later has been reworked to be wizard based and therefore 

guides the user through the calibration process. The calibration requires setting three calibration 

points. 

The new FRAP calibration also allows to manage more than one calibration which is needed on 

systems where more than one objective and/or filter is used for FRAP experiments. The FRAP 

calibration manager, where FRAP calibrations can be created and managed is located in the 

Config > Polytrope I / II and Yanus> FRAP Calibration or in Config > Yanus > FRAP 

Calibration. 

 

 
Figure 69: FRAP Calibration management dialog 

 

 

 
Figure 70: Calibrating FRAP in LA 

 

This control is very similar to the FRAP Hardware configuration control in that it has two sliders. 

To use this tool one must position the FRAP spot in three separate locations in the sample (top 

left corner, middle right side, and middle bottom side) to establish a FRAP calibration. 

 

Starting at the upper corner select a FRAP region and turn the laser on and then off. Adjust the 

sliders where the top slider represents X Axis calibration and the bottom slider represents the Y 
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Axis calibration and repeat the FRAP process by turning the laser on and off. Repeat this process 

until the FRAP region and the fluorescence depleted region overlap. 

 

Move to the middle left position and repeat the procedure until the FRAP region and the 

fluorescence depleted region overlap. 

 

Move to the bottom center position and repeat. 

 

To complete the FRAP calibration set three FRAP regions at each of the three previous positions 

and turn the laser on and off one time. Fine tune the FRAP regions with the sliders until all three 

regions are correctly located with the fluorescence depletions. 

 

Check the calibrated box and save experiment to save the FRAP SW calibration. In future 

experiments as long as the check box is still active the same calibration values will be used. 

 

This control builds on the primary calibration of the HW. If after following this process a 

calibrated FRAP is not able to be achieved then it will be necessary to return to the hardware 

calibration and repeat both the HW and SW calibration process. 

 

 

13 External device controls 
This chapter describes how to control external devices and setup custom GUI controls in LA. 

It allows for example to set multiple external devices like TTL, analog outputs and serial devices 

with one button click. Besides the controls management, there’s also a direct control of the 

configured external devices. 

To use this control, at least one TTL-Out, Trigger-In, Analog Out or RS232 has to be configured 

in the Device Manager. Of course any configuration combination of these devices is possible. 

 

13.1 Direct control of external devices 

With the Direct control it is possible to change the state of the external devices on the ICU. The 

controls are grouped into tabs (Digital, Analog and RS232). The changes made to a device state 

take immediate effect.  

 

13.2 Configure custom User Interface elements for controlling devices from LA 

The LA software allows the user to create custom interface elements for controlling external 

devices. The control will show up in a separate panel on the left side of the LA main window 

below the camera control panel. 

The process of defining the user interface (UI) elements is started by selecting the menu Config > 

External Devices > User Controls Manager ().Pressing the ‘New’ – button will start the Wizard 

for creating new UI controls for external devices. 
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14 Configuring LA for the first time 
Usually the imaging and iMIC systems form TILL Photonics come pre-configured and the user 

can start right away after the system has been installed by a TILL Photonics technician. 

However, sometimes a system is setup from the scratch and the user(s) will have to start over 

again. 

 

This chapter describes briefly how-to setup a device configuration and how-to import an old 

configurations. This chapter goes through the start up process step by step on a fresh installed 

computer. If LA is re-installed on a computer some of the steps might not be necessary.  

 

14.1 The Configuration Import dialog 

When LA is started for the first time and no configuration file is found it will show a dialog 

where the user can directly import configuration files from a directory. After selecting a directory 

LA will import all configuration files. If a user wants to select only a few hardware 

configurations from all available configurations in the config files, he has to skip the import at 

this point and do this in the Device Configuration dialog. 

 

14.2 The Welcome Dialog 

After the configuration Import dialog LA will open the Welcome Screen. This is usually the first 

dialog a user will see if LA has configurations file in place. A description of all options of the 

Welcome Dialog can be found in chapter 2.1. 

 

 

For a single user system only a valid hardware configuration needs to be created. If no 

configuration file was imported before LA will display a message “Missing device configuration. 

Please press edit to create a device configuration” right below the configuration list control. The 

 

 
Figure 71: Welcome Dialog at first start of LA without any configuration 
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14.3 The Device Configuration dialog 

After the Welcome screen, the first step is to go to the hardware configuration dialog 
where the devices have to be connected. If no configuration is present LA will ask on 
the first start to import an older configuration. However, if no older configuration is 
available the user has to cancel the import dialog and continue to the Welcome screen. 
In the Welcome screen the user will find a message printed in red that no 
configuration is found and that he needs to create one first before he can continue. 
The Device Configuration dialog is opened by clicking on the Edit-Button to the right 
of the (still empty) configuration list control. 
 
The hardware configuration supports a drag and drop interface to add new hardware 
to the hardware desktop.  Simply click on a desired hardware item from the list on the 
left and drag it over to the desktop white space on the right.  Note that double clicking 
is not sufficient to add the hardware. 
 
If this is a new system then notice that the configurations already reflect the factory 
default settings. The only thing that is required at this point is to simply ensure that 
the cabling is correctly connected. 
 
If however this is a new system or a system update it will either be necessary to 
restore to factory defaults via the CD provided or to manually reconfigure the 
hardware configurations with the use of the configuration utility. 
 
Most devices require additional configurations.  As every device is different this is 
achieved in the hardware configuration by right clicking on and selecting the 
hardware component in question once it has been dragged onto the configuration 
desktop. Control windows capable of uniquely configuring the chosen hardware will 
pop up. This is where the “Sample Hardware Connectivity Diagram” comes into play.  
It is a generic representation of a very extensive hardware configuration on how to 
connect the various cables of the system. By simply following the diagram, one can 
quickly and easily connect the system hardware components together. The hardware 
configuration tool is the software representation of these physical connections.  It 
allows the software to know which COM ports, which triggers, which digital/analog 
signals have been connected to which devices.  This configuration tool should match 
the physical connectivity of the system for the software to function correctly. 
 
There is also an important pull down box at the bottom of this screen which requests 
the default method for saving and transmitting stored images.  This sets the default 
path for the transmission of acquired images.  When set to the Offline Analysis 
Streamer the captured images will be sent to the Offline Analysis application for 
archival.  When set to TIFF all images will be stored as OME compliant metadata TIFF 
images in the default data folder of the LA installation. 
 
The following flowchart shows the hardware configuration process. 
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Figure 72: Hardware Configuration Workflow 
 

Once all of the hardware has been selected and placed on the hardware desktop and 
checked for secondary configuration options, it is time to begin using the Live 
Acquisition solution.  Simply click on connect and the LA system is started and 
configured for you based upon your hardware selection.  This means that when the 
program executes it only has the controls, menus, and parameters of the associated 
hardware making it easier for you to control the devices without having to negotiate 
complex and lengthy menus for hardware and options that are not present on the 
system.  
 
If after connection one of the selected devices is highlighted in a red circle it means 
that the system could not connect the configured hardware devices and the highlighted 
element needs to have its configuration proofed. 
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Once the system has been configured it is no longer necessary to reconfigure it with 
every new start.  The last known system configuration will be used at startup.  This 
allows the possibility to change configurations if the hardware has been changed but 
in most cases simply click on connect to begin using the software. 
 
If you are updating a previously installed LA version the older configuration settings 
will be saved and will not need to be reconfigured. 

15 User management 
The Live Acquisition software features a sophisticated user management independent of the host 

operating system (e.g. Windows). This allows labs/facilities/departments to manage multiple 

users on one setup without requiring the IT department to set-up User accounts on the operating 

system level. 

To manage the list of users the button with the pen icon left to the user list control has to be 

pressed. If LA is started for the first time and no configuration is available or was imported, a 

new configuration has to be created to continue. 

 

 
Figure 73: Welcome Dialog with user management 

 

The Welcome dialog differs between Live Acquisition (LA) and Offline Analysis (OA) as in the 

latter one no hardware configuration controls are needed (Figure 74). If LA and OA are used on 

one computer, all user accounts are shared between the both programs. This means that if a new 

user is created in on of the applications it is automatically available in the other one, too. 

 

 
Figure 74: Welcome dialog of Offline Analysis 
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15.1 Add, rename and delete users 

Adding user is done by clicking on the “Edit” button to the right of the user list control. This 

opens the “User Management” dialog. 

 

To add a new user to the list of users, simply press the “New …” button . LA with then ask for a 

user name. 

Once a user is added, additional properties can be edited by selecting the user in the list. 

This dialog allows adding additional metadata about the user like first and last name as well as 

the email address and Institution. These additional data will be added to the OME (TIFF and 

XML) image files created by the Live Acquisition software. 

 

 
Figure 75: User management dialog 

 

By default a new user will inherit all hardware configurations of the Admin(-istrator). 

To rename or delete users, they have to be selected and can then be deleted or renamed by 

pressing the buttons. 
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16 Experiment references 

16.1 Time Lapse 

The Time Lapse Experiment and the 2 Wavelength Experiment are closely related.  For this reason 
the two experiments are able to switch between each other as well as being launched from the same 
Experiment control.   
 
The Experiment Window list has the following four controls added: 
 

 Mode of Operation Button: Time Lapse or 2 Wavelength 

 Light Source 
 Wavelength 
 Exposure 
 Cycle(s) 
 Cycle Count 
 Delta Time 
 Total Cycle(s) 

 
Here one can independently set the wavelength, exposure time, cycle, and cycle count for the two 
separate wavelengths.  The wavelengths will be switched and images acquired one directly after the 
other as fast as the hardware can switch the image exposure time/ cycle for each wavelength and 
read out the image from the camera.  When the cycle count triggers a new pair of images the process 
is repeated.  The independent cycle count of the second wavelength is at the moment not a feature 
that can be used.  It is prepared for future expansion so that the two can be separated and set at 
different wavelength harmonics. 
 

 
 

Figure 76 : Time Lapse / 2 Wavelength Experiment Controls 
 
 
Switching between Time Lapse and 2 Wavelength is achieved with the button at the top of the 
Experiment Window.  The Time Lapse controls are similar to those of the 2 Wavelength experiment 
but with only a single wavelength.  The only difference between experiments is that in a 2 
Wavelength mode 2 images at 2 different wavelengths are taken every time the experiment repeats 
instead of a single image which is the case with the Time Lapse mode. 
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16.2 Multi Wavelength 

The Multi Wavelength Experiment window list has the following four controls added: 
 

 Light Source 
 Number of Wavelengths Selections 
 Wavelength 
 Exposure 
 Cycle 
 Filter Selection 
 Cycle Count 
 Delta Time 
 Total Cycle(s) 

 
The Multi-wavelength experiment is a more advanced version of the 2 Wavelength experiment but 
operates under the same principles.  The major difference is that each of the wavelength selections 
is associated with:  

o Light Source 
o Wavelength 
o Exposure 
o Cycle 
o Filter Selection 

This means that each of the wavelength selections needs to be configured at system start.  At the 
execution time of the selected wavelength the filter will be changed as needed and the other 
parameters set.   
 
Each selection will receive its own configuration information and is not dependent on the settings of 
the others.  Simply click on one of the selection buttons and configure the rest of the fields.  The 
information will be saved with that wavelength selection.  Clicking on another selection button will 
allow one to configure the remaining selections accordingly.  Clicking on a previously configured 
wavelength selection shows the values it has been configured to.  Note that this also allows unique 
combinations of light sources. 
 
If filter changes are needed then this experiment is not perfectly suited for time lapse / ratio 
experiments because of the time required to change the hardware filters but may still be used to 
deliver useful analysis.  If no filter changes are needed then the experiment is a fast and very useful 
one for doing rapid spectral analysis applications. 
 



                         Live Acquisition Software Documentation v2.2.0 

100 

 

 

Figure 77: Multi Wavelength Experiment Controls 

16.3 Z-Stack 

The Z-Stack experiment allows taking relative z-Stacks at the current position. The user can set 

the number of planes, the step size and the direction 

 

 

16.4 Absolute Z-Stack 

The Absolute Z Stack experiment allows the user setting the top and bottom of a Z Stack and to 

calculate a optimal z step size according to the Nyquist criteria. The step size is calculated 

according to the following formula: 

 
 

The calculated step size is then ideal for image data that will be deconvolved with deconvolution 

software. 

The Step Size and Slices controls are dependent on each other and will change is one or the other 

is changes. The defining/limiting parameters for Step Size and Slices are the top and bottom 

position  
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Further the Absolute Z Stack has controls for navigating in the defined Z-Stack. First of all are 

the “Go” buttons with which a user can go to the previously set top or bottom positions. 

Additionally the Slice Explorer can be used to inspect the defined Z Stack by dragging the slider. 

 

 
Figure 78: Absolute Z-Stack control 

 

The Absolute Z-Stack can also be used as a relative Z-Stack. Setting the Positioning to “Relative” 

will allow acquiring Z-Stacks relative to the current z-position. The current position is then the 

center of the Z-Stack. In case a Z-Stack of 10 Planes/Slices should be acquired, five planes will 

be acquired below the current z-position and five above the current z-position. The controls for 

setting the top and bottom position are disabled in this mode. 

16.5 Z Stack in Time 

The Z Stack in time has the same controls as the Z Stack experiment with the addition of the 
controls from the Time Lapse / 2 Wavelength experiment. 
 
This experiment is provided as a learning tool on how one takes the various sample experiments 
and merges and modifies them into something tailored for the application workflow of the 
researcher. 
 
The workflow of this experiment is as follows.   

 A plane from the Z Stack will have either 1 or 2 Wavelength images taken. 
 The next plane of the Z Stack will then repeat the process until all planes are completed. 
 The cycle count will then be decremented and the process will be repeated across the 

entirety of the Z Stack. 
 
What is important to note about this DEFAULT experiment is that no data sorting is made at the LA 
Browser or TIFF streamer and that the images have to be manually regrouped by matching the 
image capture metadata. 
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Figure 79: Z-Stack in Time Experiment Controls 

 
This process can be automated by replacing the default provided Z Stack in Time experiment with 
the Z Stack in Time Serialized.  The details on how to do this can be found in Appendix B and 
describe the process needed to update and modify C# plug-in. 
 
After the updated plug-in has been installed then the LA Browser now has 1 (or 2) separate stacks.  
The first (and second) are default Z Stacks in Time with a single wavelength represented.  This 
allows a 3-D/4-D model of the data to be analyzed per wavelength.  The two separate Z Stacks can 
then be overlaid such that the Ratios of the wavelength data can be analyzed in an offline manner. 

16.6 Tile and Stitch 

The Tile experiment is both a calibration tool and a manual screening application.  It allows a large 
region to be mapped with individual images and then later stitched together into a complete image. 
 
The Tile and Stitch Experiment window list has the following two controls added: 
 

 Overlapped Pixels X 

 Overlapped Pixels Y 
 
In the Navigator control ROIs and POIs (regions and points of interest) are chosen.  The only other 
control is a correction factor on the number of pixels that need to be overlapped to correct any 
image imperfections in hardware calibration.  This is based on a camera pixel overlap so that the tile 
and stitch algorithms of the LA Browser or TIFF Streamer can be used for visual inspection of the 
accuracy of the tiling movement. 
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Dragging the mouse cursor over a region in the Grid View with the left button depressed will select a 
ROI.  Single clicking into any grid position with the left mouse button will select a POI.  Depressing 
the right mouse button on any selected point removes it from the list to be tiled.  The yellow cursor 
highlights the current hardware position of the stage.  Disabling hardware motion allows selection of 
POIs and ROIs without the hardware moving during the setup.  Enabling the Hardware causes the 
XY stage to move to each selected point thereby giving the user an overview image as the experiment 
is being configured. 
 

 

Figure 80: Navigator Control 
 
 

 
 

Figure 81: Tile and Stitch Experiment Controls 

16.7 Relative Tile 

The Relative Tile experiment allows to acquiring a tile of n by m images around the current 

position. The current position will be the center of the Tile scan.  

 

 
Figure 82: Relative Tile experiment parameters 

 

Using this experiment with a MarkerScan experiment allows acquiring Tile experiments at each 

position in the list of the MarkerScan.  

 

16.8 FRAP 

 
The FRAP experiment is one that allows use of a laser for point, line, and polygon based photo 
bleaching/activation of a sample.  In the supplied FRAP experiment it has been combined with an 
optional 2 Wavelength / Time Lapse experiment as these three experiments tend to be used together. 
The FRAP experiment is available as experiment in LA and as a building block in the Protocol 
Editor for larger protocols.   
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The workflow of this experiment is as follows.   
 A number of reference images will be taken (with the same light/exposure setting as the 

Time Lapse) 
 Each ROI image will be FRAPed (optionally multiple times) 
 Each ROI will then be revisited and FRAPed until all loop count FRAP cycles have been 

completed 
 The Time Lapse / 2 Wavelength experiment will then begin to execute 

 
 

 

Figure 83: FRAP Experiment 
 
The FRAP Experiment window list has the following controls added: 
 

 FRAP region color selection 
 Alpha value 
 Display Option for the Alpha value (Visible) 

 Alpha counterclockwise vs. clockwise rotation selection 
 Line count 
 Bleach time 
 Loop count 
 Whole Loop Count 
 Reference cycles 

 
The FRAP controls are found at the top of the Experiment Window.   
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Figure 84: FRAP Experiment Controls 
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Figure 85: FRAP Parameters 
 
The above figure represents the way the FRAP parameters are handled.  The Alpha combo-text box 
is the angle from the bottom left corner of the region of interest to the horizontal plane.  The 
checkbox for visible displays the FRAP raster lines on the GUI.  The line count combo-text box is 
used to determine how many lines will be populated in the chosen region of interest.  The more lines 
the better the FRAP detail but the larger the bleaching time on the sample.  Bleach time is the 
amount of laser exposure time for the complete region of interest.  This does not include the time 
that it takes the hardware to move to a new line as the laser is blanked during this time.  The last 
control is a counter that allows re-bleaching of the same selected region of interest in an iterative 
fashion.  This is particularly useful when doing time lapse analysis of FRAP regions. 
 
The last parameter in the control is the number of reference FRAP images to take before switching 
over to 2 Wavelength / Time Lapse aspect of the experiment.  This allows a FRAP analysis to be 
made and then an Epifluorescent movie to be made directly afterwards in either 1 or 2 separate 
wavelengths. 
 
The lower half of the Experiment Window possesses the same controls as that detailed in the section 
for Time Lapse 2 Wavelength and their usage can be found there. 
 
When all the parameters have been entered and the experiment setup has been saved then simply 
press the ‘Record’ button to begin execution of the acquisition. 

16.9 DynamicFRAP 

The DynamicFRAP experiment is made for applications where the time point and location of the 

FRAP ROI is not known. Application where the loading of vesicles is observed or other transport 

activities are monitored this FRAP experiment can help. 

The DynamicFRAP experiment allows choosing between three shapes of FRAP ROIs, a point, an 

ellipse and rectangle type shape. 
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16.10 FRAP on Demand 

The FRAP on Demand experiment allows the user to set the Time point when the previously 

defined FRAP ROIs should be “frapped”. In contrast to the normal FRAP protocol there is not 

option to edit the number of reference cycles as this protocol will start with an endless loop and 

therefore acquires images until the user presses the “FRAP Now!” button. The images acquired 

before the FRAP use the same parameters as in the Time Lapse part are shown. 
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16.11 FRAP on Demand (PE) 

The “FRAP on Demand (PE)” is only available in the Protocol Editor of the LA software. It has 

the same parameters as the “FRAP on Demand” experiment, but is capable of being combined in 

a Protocol Editor workflow. 

 

16.12 TIRF EPI 

The TIRF / Epifluorescence experiment is similar to the 2 Wavelength experiment.  In this case a 
single wavelength epifluorescence and multiple wavelengths (depending on laser line combiner 
settings) TIRF image are acquired. 
 

 TIRF image(s) will be taken 
 A time lapse of epifluoresent images will be taken 
 The process will repeat until all loops have executed 

 
The first is a control allows entry of exposure time and cycle time for the TIRF image(s). 
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The second is a fluorescence control that allows the exposure time and cycle time to be set as well as 
the wavelength.  At the bottom of these two controls is cycle count with no delay being provided 
between cycles.  It cycles between two images at multiple wavelengths as fast as possible.   
 
The third section of the control panel allows two separate focus(es) to be established as TIRF and 
epifluorescence are at slightly different focus depths.  The search triggers the corresponding light 
source until set is pressed storing the local focus position.  During this calibration time all the 
primary control panel functions are available to determine proper focus depth. 
 

 

Figure 86: TIRF EPI Experiment Control 

16.13 Marker Scan 

The Marker Scan protocol item allows managing a list of xyz position markers. The user can 

select markers from a list and add them to the list of markers that will be addressed during a 

protocol. Users can add child items to the Marker Scan item to execute for example a Z-Stack at 

each marker position. For more detail please have a look at the Protocol Editor chapter. 
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Figure 87: Marker Scan protocol item 

16.14 Marker Focus Map 

The Marker Focus Map protocol item allows correcting the Z-position of user defined and pre-

defined marker prior to a Markers Scan item in a Protocol Editor workflow. It allows modifying 

the number of focus steps and the step width. The second step count and step width is for a fine 

focus on the best found position with the coarse movement. 

 

 
Figure 88: Marker Focus Map 
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The “Persist Z Start Position” will start the search for the best focus position always from the last 

z-position the user has set either by moving to a position in the protocol. If this is the first item in 

a protocol the start position will be the current z-position from the live view. 

Under Marker Scan Control the user can select the markers, user defined or pre-defined, where 

the focus position should be corrected. This works in the same way as in the Marker Scan Item. 

 

 

16.15 Snaphot 

The Snapshot item takes one image with the selected light source for illumination. If used in a 

Loop the user can build a time lapse experiment or multichannel experiment from scratch. 

However, putting a Snapshot item in a Loop will not allow overlapped readout-exposure modes 

of the camera even if the camera supports it, as each Snapshot item will re-program the camera. 

 

 
 

16.16 Wait for Trigger 

Wait for Trigger is a control item for Protocols as it allows to control the workflow of the 

protocols by wait for an external event. This item can be used to synchronize the start of two 

setups like imaging and electrophysiology. Where one of the two setups would be the “master” as 

it would send a trigger to the other as a start signal. 

 

 
 

 

16.17 Wait for Key 

Here the protocol workflow can be interrupted to wait for user input. The user has the option to 

enter customized text message that will be displayed until a key is pressed. 
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16.18 Time Delay 

The Time Delay item allows delaying the execution of protocols by a certain time. This item is 

usually used in conjunction with loop constructs. 

 

 
 

16.19 Loop 

The Loop item allows building simple time lapse experiments and also complex protocols by 

nesting multiple loop items. 

It allows setting the number of repetitions (Loop Count) and a Cycle Time. However, the cycle 

time will not be used if a PC controlled experiment is nested in the loop. PC controlled items are 

the ‘AutoFocus’ and ‘Wait for Key’ experiments. These two protocols need commands from the 

PC to continue, like a key pressed on the keyboard or the analysis of the focus algorithm. As the 

time point, when the results from these items are ready, is undefined, the cycle time will be 

ignored in this cases. 

 

 

16.20 Trigger (Digital Out) 

With the Trigger protocol item the user can send TTL triggers from the ICU to other devices. 

There are multiple options to control digital triggers in a LA protocol. 

 
 

The user can select between multiple digital outs that are available on the ICU by selecting them 

from the drop-down-list. The analog out ports have to be configured in the LA device 

configuration dialog on start of the LA. 
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The next option available to the user is whether the user wants to set the Digital out to one of the 

two levels, zero or plus five volts, or if the user wants to generate a pulse to +5V. 

The time point when the TTL will be modified can be changed by the user with the options 

Before Next and After Next. Entering a time in the offset control will execute the TTL 

modification the entered time before or after the next item in a protocol tree. 

16.21 Analog out 

 

With the Analog Out item the user can set one of the analog outs of the ICU to a certain level in 

the protocol execution. The voltage can be set to an absolute value or is used in a loop increased 

or decreased from loop to loop iteration when selecting the relative option. 

References created with the External Control feature (Chapter 13) can also be used here by 

selecting them from the drop-down-list labeled “References”. 

 

 

 
 

The time point when the analog voltage will be modified can be changed by the user with the 

options Before Next and After Next. Entering a time in the offset control will execute the analog 

voltage modification for the given analog out port the entered time before or after the next item in 

a protocol tree. 

 

16.22 RS232 Out 

With this item a RS232 command can be sent to a connected device. The time offset relative to 

the succeeding command can be adjusted. 

 

 

16.23 RS232 In Out 

This item allows sending a command to an RS232 device and shows the response from the 

corresponding device.  
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16.24 RS232 Acknowledge 

This item will wait for a defined text string defined by the customer. Once the defined string has 

been received the workflow will continue. This works much like a “wait for trigger” – item. This 

only works with serial ports (Com-Ports) on the PC, not on the ICU. The time offset relative to 

the succeeding command can be adjusted. 

 

 
 

16.25 Light change 

This item is used if a change of the light source is required in a protocol. Usually this is used if 

protocols are built with Snapshots and Loop items from scratch. 

If used before a Time Lapse or Multi-Channel item, this will change the light source and its 

parameters accordingly. 

 

 
 

16.26 Exposure change 

The “Exposure Change” allows changing the exposure time in succeeding experiments in a 

protocol workflow. This works with experiments like the Z-Stack, Absolute Z-Stack, Tile and 

Relative Tile where no controls for setting the exposure time are present. 

The “Exposure Change” has therefore no influence on experiments like Time Lapse, Multi 

Channel, FRAP or TRIF-EPI. 
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16.27 Filter Change  

The “Filter change” allows changing the filter position in succeeding experiments in a protocol 

workflow. This works with experiments like the Time Lapse, Z-Stack, Absolute Z-Stack, Tile and 

Relative Tile where controls for setting the changing filters are not present. 

The “Filter Change” has therefore no influence on experiments like the Multi Channel. 

 

 
 

16.28 Flash 

The Flash item is made for experiments, where the user needs to expose the sample to light but 

does not want or need to take an image with a camera. This is usually the case when working with 

caged compounds or other photo activated substances. 

 

 
 

16.29 Auto Marker 

The Auto Marker adds a xyz-Position Marker to the xyz Position marker list in the LA control 

panels.  

 
 

16.30 Auto Focus 
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16.31 Move XY 

If a motorized xy-stage is installed on the system it can be moved with this item. The user can 

select between absolute and relative movement. 

 

 
 

16.32 Move Z 

When working with an iMIC or an imaging system with a Pifoc, the Z-Move experiment allows 

changing the z position with the Z-Move experiment. 

 

 
 

 

17 Supported Hardware and general features 

17.1 Supported motorized Microscopes 

 iMIC series 

 uiMIC 

 MORE microscope 

17.2 Supported TILL Hardware 

 ICU (with CCM and CCM2) 

 SCU/SPU 

 Polychrome V 

 Oligochrome 

 iMIC Dichrotome Image Splitter 

 iMIC Polytrope I and Polytrope II Mode Switch 

 Yanus Scan Head (digital control with DSC) 

 iMIC Fixed Stage 

 iMIC Large Stage (Prior) 

 iMIC Integrated Stage 
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 iMIC Transmitted Light 

17.3 Cameras 

 

 AVT Stingray F-145B & Pike F-145B 

 Andor Clara & Clara E 

 Andor Luca S & R 

 Andor iXon 885, 888, 897 

 Hamamatsu Orca R2 

 Hamamatsu Orca 03G 

 Photometrics Evolve 512 

 QImaging Retiga 2000 RV & DC, EXI Aqua & Blue 

 TILL Imago QE / PCO Sensicam QE 

 

17.4 Supported Light Sources 

 Polychrome V 

 Oligochrome 

 LED(s) (up to 5) 

 LLC - Laser Line Combiner with Pegasus AOTF 

 IR Illumination 

 Trans-Illumination 

 

17.5 Supported Expansion I/O Devices 

 3D Connexion Space Navigator Joystick 

 USB HID Joysticks 
 

17.6 Real Time Execution and Control Unit specifications 

  µSec resolution in protocol response times to external triggers 

 1 mSec resolution between camera and light source timing 

 Protocol timing can be structured for timing optimization in a dynamic fashion with 

support for start at start, end at end, and start at end whereby each protocol action can be 

timed to any other protocol action in various formats 

 1µSec galvo/laser control timing 

 Guaranteed timing generated by OS independent Imaging Controller Unit (ICU) 

 Zero-position focus map correction 

 Real time hardware monitoring preventing hardware device collisions 

 More than 300 full frame image readout with current fast overlap readout cameras are 

possible 

 Intelligent acquisition to memory or direct to disk (depends on timing requirements) 

 Real time (PC Connectivity speed) FRAP/TIRF region of interest changes 

 Parallel real time protocol execution allowing pre-built protocols to be paused, started, 

and resumed when other protocols are active 
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 Loop with in loop complex protocol execution / decision matrix(es) 

 Digital outputs and inputs to control other devices 

 Control external devices by TTL pulses 

  “Wait for” Triggers 

 

17.7 Software Extensibility 

 Common data exchange (OME-TIFF, OME-XML) 

 Import of OME-TIFF compatible files 

 Driver level SDK API encapsulates core functionality of the iMIC microscopes 

 

18 FAQ and Trouble shooting 
 

In this chapter solutions and trouble shooting for known issues are described. 

 

 

Q: LA crashes after the devices have been initialized and I can see the main window  

 

A: This looks like a driver issue either with the graphics card or with a camera. In both cases a 

driver update is recommended. Typical is that the LA main window has a plain gray background 

and no black area is shown where the camera image would be displayed. 

 

Graphic card drivers can be downloaded from the nVidia or AMD/ATI websites. 

If the computer was setup from the scratch the first thing to do before or after the Installation of 

LA is to update the graphics card driver. 

If problems remain a too old camera driver version could be the cause for the crash. In this case 

please contact the service at TILL Photonics. 

 

Q: I cannot update my dongle with the V2C-File I have received. 

 

A: Check your settings of the Anti-Virus software they might be too strict and will not allow the 

LARUS.EXE to update your USB-dongle. Please contact your IT department to change this. 

 

 

Q: LA won’t start on a newly created user account, but it starts on other accounts. 

 

A: If you are running Windows 7 (or Vista) this might be the User-Access-Control (UAC) that 

interferes. Try running the LA software as Administrator by right-clicking on the LA or OA Icon 

on the Desktop and start LA/OA by “Run as Admin…”. 

If this works you can set the UAC control in the Windows Control panels to a lower security 

level. 
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Q: LA Software says that the Dongle is required but it is already plugged in. 

 

 
 

A: If you have installed other software that needs a dongle, it might be necessary to 

reinstall/repair the Dongle driver. To do this, follow the instructions: 

 

If you have an Anti-Virus software running on your computer you might first check if the security 

settings are too strict. This can prevent the installer from copying the driver files to the windows 

directory. In this case please contact your IT department. 

 

Go to the Drivers folder e.g.( c:\program files\TILL Photonics\Live Acquisition\Drivers) of the 

Live Acquisition software and run the HASPUserSetup.exe. Then follow the on screen 

instructions. 

 

 
 

Select the “Repair” option and press “Next”. 
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Simply press “Next” 

 

 
 

Wait until the software has fixed the drivers. Then close the program. If problems still persist 

check if the security setting of your virus scanner are set to high. In this case please check first 

with your IT department. 
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